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Congratulations. You now have the fastest, most reliable data protection
for NetWare servers. Replica™ for HP SureStore Tape provides an
entirely new way of solving your NetWare data protection problems with
a powerful storage management solution.

Replica Backup protects your data by replicating entire drives. When a
disaster strikes, you reinstall the operating system, NetWare, and
Replica, then use Replica to recover your data volumes. Traditional
backup programs are notorious for failure to restore individual files.
Replica lets you mount a tape to easily recover individual files and
folders, as well as volumes.

Replica Single Server also replicates the entire server, including DOS,
NetWare, security and partition data. As a result, you can completely
recover from disasters by recovering the entire server, as well as use all
the features included in the Backup version.

Many HP tape devices support HP One-Button Disaster Recovery
(OBDR) in which your server restarts using data on the tape itself. Other
tape devices use standard Replica Disaster Recovery methods.

Replica treats server data as whole objects, transferring complete
volume information to tape or disk without opening and closing files. It
also replicates the server’s security, partition data, and the non-NetWare
partitions. This unique patent-pending method is called Object
Replication Technology™. Object Replication Technology makes it
possible to use the full speed of your tape drives, no matter how many
files are present or whether they are large or small.

Replica offers the fastest, most reliable way to protect your servers. This
version of Replica provides even easier features to help you back up and
restore data from your desktop.
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The Replica Software

Replica uses Object Replication Technology™ to transfer server or
volume objects at high speed—as fast as the tape device can receive
data. Replica protects your data while users continue to work, caching
data as needed to ensure that a true copy of the disk is replicated. You
won’t have to dismount volumes or shut down the server. All your data is
protected, including open files; Replica even protects deleted files if you
want.

Working in Windows 95, you can easily replicate server and volume
objects and recover the server, volumes, or files when needed. Replica
makes it easy to manage your tapes and recover your data. You can also
perform many operations directly from the NetWare console.

What Replica can do with your servers and server objects:

� Replica uses Object Replication Technology to protect NetWare 3.12
or 4.11 server or server objects, including NetWare volumes and
security. Replica backs up the object to tape or to a volume on the
Host Replica Server.

� If you have the Single Server version, Replica can use Disaster
Recovery to recover the entire system in less time than it takes to
read the instructions for other systems.

� The Replica Backup Configuration Wizard helps you configure a
default backup job to protect your data automatically.

 
� Replica provides Direct Media Access for user controlled nearline

storage that allows file access from replicated tapes. Any user can
use any software (even Windows Explorer) to access and copy files
and execute programs from the tape.

� Replica can recover the entire volume or security or any files from a
server or individual volume replication.

� Replica can copy  an entire volume to an unused disk volume or
unassigned free space on the Host Replica Server.
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This table summarizes the recovery capabilities of Replica:

If you replicate .... to Replica can recover ...

 An entire host server Tape The entire server (with the
     Single Server version)
Any or all storage objects
Any file or directory

 Security Tape The security object

  Multiple volumes Tape Any volume
Any file or directory

 One volume Tape The volume
Any file or directory on it

 One volume Disk The volume indirectly when
you mount the disk

Major Features

Replica provides many features that make it superior to traditional
backup products. These features provide the speed and safety you need
in today’s fast-moving and ever-changing world. This section explains
the major features.

Object Replication Technology™

Replica protects an object (server or volume) by doing a logical
block-by-block capture of its data to a backup device, usually a tape.
The resulting replication is neither an image nor a file-by-file transfer
but has the best features of both. The technology is a totally new storage
management solution; it uses better techniques to produce faster, more
reliable results.

� The live server replication process is faster than any traditional
backup method, both in replication and recovery. Replica sends
data to the tape as fast as the tape can receive it.
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� Replica works with live servers, so it can replicate data while the
server is up. The reusable cache lets users write to the disk during
replication, so even open files are protected. While the system may
be a bit slower, most users won’t even know when replication takes
place.

� Replica takes each block that contains data and transfers it onto the
tape. It doesn’t pick and choose among what’s there; you get it all. If
you want, Replica even includes blocks containing deleted files, so
you can use NetWare’s utilities to recover previously deleted files
from volumes recovered under Replica.

� You can recover entire objects under Replica or directly access files
on any volume. Replica mounts a replicated tape as a read-only
NetWare volume and gives you access to anything you need. Full
NetWare user security is enforced.

7/24 Live Replication

Replica backs up active file systems without disabling user logins or
read/write activity. As a result, it eliminates the backup “window” and
open file errors. At the moment backup begins, your data is secured;
even files deleted during the replication process are protected. Replica
captures an entire volume at a specific moment in time. Your business
isn’t interrupted and the process is so painless you can schedule several
backups a day if you want.

Direct Media Access

When you store data on your computer’s internal hard disk, you use
online storage. You can also use offline storage, on tapes or on disks,
often at another location; replicated disks and tapes serve as offline
storage. Now Replica bridges the gap with true nearline storage on tape.
Tell Replica to mount a volume on the tape for file recovery (Direct
Media Access) and Replica makes the volume available.

� Replica mounts the volume on the tape for you. You can use any
Windows application or utility, including Windows Explorer, to
access, copy, and execute files from the tape.
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� You can let your users recover their own data after Replica mounts
the tape; it maintains the same security as the original volume.

Disaster Recovery (Single Server only)

Any backup software package can restore one of its backed-up volumes.
But what about a complete server? Do you remember installing your
operating system (such as DOS) and configuring NetWare?

Replica can recover using only the server backup tape if your tape
device and system support HP One-Button Disaster Recovery (OBDR).
(See the online help or Chapter 4, Disaster Recovery, for details on how
to tell if you have the support.) Otherwise it helps you create Disaster
Recovery floppy disks; most servers require only two floppy disks.

Just restart your crashed server using the tape device if you can,
otherwise use Disaster Recovery Disk 1 and insert additional disks when
prompted. In either case, Replica recovers the system from a replication
tape and you are back in business.

To be prepared for Disaster Recovery:

� Use Replica regularly to protect your servers.

� If you can’t use OBDR, use Replica to create Disaster Recovery
disks.

Replica can recover an average 2 GB server from a complete crash in
less than an hour using a DAT tape drive.

Quick Easy Features

Replica for HP SureStore Tape provides several ease-of-use features that
make protecting data and recovering files painless.

� The Backup Configuration Wizard helps you configure or
change a regular backup job.

� The Replica Backup desktop icon runs the job you configured
through the Wizard at your command.
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� The Replica Restore desktop icon opens the appropriate Replica
window, all ready to let you restore files from a volume on the
current tape.

Replica Documentation

Replica includes both online help and this electronic manual (in Adobe
Acrobat PDF format). Both components show you what to do and help
you make choices for protecting your data.

User’s Guide

This User’s Guide helps you get started, perform the basic procedures,
and solve any problems that occur. In addition, it provides information
about commands you can use to perform critical Replica operations
from the NetWare console.

See Chapter ... For information on ...

1. Installation Installing Replica and setting it up to work
with NetWare

2. How Replica Works Using the Windows interface and Quick
Easy features

3. Replicating Replicating volumes

4. Disaster Recovery Preparing for and using Disaster Recovery

5. Recovering Recovering individual files and folders, as
well as full volumes

6. Status Monitoring progress of Replica jobs

7. Utilities Managing tape databases and tapes

8. Console Operations Using Replica at the NetWare console

9. Troubleshooting Solving problems with Replica
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Online Help

The Replica Windows application includes extensive online help. You
can get information on the screens and dialog boxes, as well as detailed
How-To procedures for whatever you need to do.

To find out ... Do this ...

What a field is for or how to enter values Use TAB or click to select
the field, then press F1.

How to accomplish what you want with
the information on your screen

Click the Help button.

Information about specific Replica
topics

Choose Contents or Search
for Help on from the Help
menu.

At the NetWare console, type REPLICA to see a summary of Replica
console commands.

REPLICA Environments

You can use Replica to protect servers on NetWare systems that are:

� NetWare 4.11

� NetWare 3.12

Replica for HP SureStore Tape works with many different HP tape drives.
Supported devices are listed in your ReadMe file.

Replica supports SNMP alerts that communicate with HP OpenView
messaging systems when you have TapeAlert-supported hardware
installed. You’ll see messages at SNMP management consoles.
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The Replica Family

The Replica family includes additional products that give you even more
ways to protect all your NetWare and Windows NT servers.

� Replica for HP SureStore Tape is available in Backup and Single
Server versions. The Single Server version includes two types of
disaster recovery. HP One-Button Disaster Recovery (OBDR) allows
recovering a server using only a full server backup tape. Your tape
device and system must support it.

� Replica for NetWare and Replica for Windows NT are both available
in an Intranetwork Edition, which provides full backup and Disaster
Recovery. In addition, they protects remote servers  and supports
many high-performance tape drives and autoloaders.

To use Replica on multiple tape servers, you’ll need multiple licensed
copies of Replica. Check with your HP distributor for details.



Installing Replica for HP SureStore Tape is very simple. If you had any
problems during installation, review this chapter before trying again.
The decisions you must make are:

� Which server will Replica protect? Replica backs up data to the
Host Replica Server. To use more than one tape server, you’ll need
more than one server with an HP supported device installed.

� From which PC will you administer Replica? This PC must run
Windows 95 and is the one from which you install Replica. We refer
to this as the Administrative PC.

Installing Replica on the
Administrative PC See page ...

1. Prepare to install Replica. 11

2. Run SETUP.EXE under Windows 95

from the Stac directory of the

CD-ROM.

12

3. Prepare the NetWare console. 12

4. If necessary, create Disaster

Recovery disks.

5. Use Replica commands from the

Start Menu and desktop icons.
13

Setup installs the replication engine and software on the appropriate
server and the administrative components under Windows 95 on the
Administrative PC.
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System Specifications

Your system must meet these requirements:

Host Replica Server

You will replicate data to this tape server. It must have a supported HP
tape device attached.

o Novell NetWare 3.12 or 4.11

o At least 16 MB RAM

o At least 5 MB free disk space in SYS volume

o ASPI compliant SCSI controller

o At least one supported HP SCSI tape drive

o 1.44 MB floppy disk boot drive

Devices supported include HP SureStore tape devices. The complete
device list is in the ReadMe file. You can also replicate any individual
volume to a hard disk volume on the Host Replica Server.

Administrative PC

This is the PC from which you install and administer Replica.

o Windows 95

o At least 8 MB RAM

o At least 4 MB free disk space

o 1.44 MB floppy  disk drive

o Network connection to the servers being protected

Note: If you use HP OpenView with TapeAlert-supported hardware,
you can install Replica on the same Windows workstation as OpenView.

Multiple Replica Servers

If you install Replica on several NetWare servers, each Administrative PC
will be able to see and protect all Host Replica Servers on which Replica
for HP SureStore Tape is installed. You can install all from the same
computer if you like. When you start Replica at an Administrative PC, you
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choose the server to work with and log in. To work with a different
NetWare server, exit Replica and restart it.

Getting Ready

Setup asks you several questions. The installation process is easiest if
you know the answers before you begin.

Before you run Setup:

� Decide which PC you will use as the Administrative PC. This
computer must be running Windows 95. You will install Replica at
this computer.

� Decide which tape server will be the Host Replica Server.
You must map a drive letter to the SYS volume for use during
installation.

� Log in as supervisor (or the equivalent) to the server.

Setup modifies the AUTOEXEC.NCF file in SYS:System to load Replica
whenever you restart your server. Setup also creates a file called
REPLOAD.NCF that contains the commands needed to load Replica.
These are the commands:
 load stacdai

load re_agent

scan for new devices

load replica

Note: If you want support for HP OpenView, type REP_SNMP instead
of REPLOAD. It contains the line “load stacsdi -snmp” before “load
replica.”  You can add “load stacsdi -snmp” to AUTOEXEC.NCF just
ahead of “load replica” if you like.

STARTUP.NCF resides on the server’s DOS partition in the same directory
as SERVER.EXE, usually C:\NWSERVER for NetWare 4.11. Replica
requires that a line be added to it. Setup stores a text file called
STARTUP.REP on your Administrative PC in the Replica directory
containing this line:
 set reserved buffers below 16 meg = 275
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Setting Up Replica

Install Replica by running Setup from the CD-ROM at the
Administrative PC under Windows 95.

Before starting setup, make sure you are mapped to the server’s SYS
drive and logged in with Supervisor access rights.

First, install Replica at the Administrative PC

1. Insert the CD-ROM into the drive.

2. From the Windows 95 Start menu, choose Run and use

Browse if necessary to start SETUP.EXE from the Stac

directory of the CD.

3. Follow the instructions on the screen.

Setup copies Replica files to the appropriate locations. It stores the
Replica Windows application on the Administrative PC in C:\replica and
the storage management engine on the specified tape server, in
SYS:System\replica.

Next, prepare the NetWare console of the Host
Replica Server

1. Update STARTUP.NCF through NetWare’s INSTALL

utility. Make sure it contains this line:

 set reserved buffers below 16 meg = 200

 You can copy STARTUP.REP from the Replica directory

on the Administrative PC to the end of STARTUP.NCF or

type the command at the end of STARTUP.NCF.

2. To load Replica, restart the NetWare server.

If you have the Single Server version and you can’t
use HP One-Button Disaster Recovery (OBDR),
create Disaster Recovery disks for the server

Note: See the online help or Chapter 4, Disaster Recovery, for
information on how to tell if your tape device and system support
OBDR.
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 You’ll need two or three blank 1.44 MB floppy disks for

each server.

1. At the Administrative PC, start Windows, if necessary.

2. Start Replica by choosing it from theStart menu.

3. Log into the Host Replica Server.

4. Click the Utilities button on the Replica toolbar.

5. Click the Disaster Recovery tab.

6. Make sure a 3.5” floppy drive is specified in the Make
disks on drive field, then insert a floppy disk in that

drive and click Create Disks. Follow the directions on the

screen.

7. Store the Disaster Recovery disks in a safe place.

Note: You’ll find more details about creating and using Disaster
Recovery disks in Chapter 4, Disaster Recovery.

Finally, create a job at the Administrative PC

w Run the Backup Configuration Wizard from the Desktop

to create a default backup job. Chapter 3 has more

details.

The Replica Program Group

In addition to storing files
on server and client
computers, Setup creates a
program group on your
Start menu on the
Administrative PC. You’ll
find it easy to start Replica
and use its features.
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Setup also places new icons
on your Windows 95
desktop.       

To ... Use ...

Start Replica

Configure a default backup job

Run your default backup job now

Restore files with Replica

Uninstall Replica

Read the Read Me file

Get Help about Replica

Get information about Replica
product support

Chapter 2, How Replica Works, provides an overview of Replica and
shows how to set preferences.

Chapter 3, Replicating, shows you how to protect your system using the
fastest, most reliable data protection for NetWare servers.



The Replica Administrative PC makes it easy to manage Replica tasks.
From the Windows application, you define and schedule replication
jobs, recover volumes or files, manage your tapes, and monitor the
status of jobs.

If you have installed this version of Replica on several servers with
supported HP tape devices, you can log into any of them when you start
Replica from any Administrative PC on the network.

Using the software ... See page ...

Using Replica Quick, Easy Features 16

Replica and its toolbar 17

The network list 18

Replica Functions 19

Replica preferences 20
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Using Replica Quick, Easy Features

Replica for HP SureStore Tape provides a Backup Configuration Wizard
and desktop shortcuts.

� The Backup Configuration Wizard helps you set up a default backup
job that may be all you need to protect you data. You choose the
volumes to be backed up and when the backup should occur.

� The desktop icons let you run your default job immediately or open
Replica to restore files from any backup tape.

To run the Backup Configuration Wizard

1. From the desktop or Start Menu, choose Backup

Configuration Wizard in the Replica program group.

 

2. Follow the directions on the screen as the Wizard steps

you through the configuration process.

Note: Replica supports one default backup job. You can modify it
through the Backup Configuration Wizard at any time.

To use the desktop shortcuts

After the standard replication job has been configured using the Wizard,
you can use the desktop icons or Start menu commands to protect or
recover data.

� Use the Replica Backup icon to start the replication job that you
configured using the Wizard. Replica starts backing up the objects
you selected to the tape in the device. The Replica application opens
the Status window so you can see the progress of the job. Chapter 6,
Status, provides more information on the Status window.

� Use the Replica Restore icon to recover files that were backed up.
Replica opens the Mount window, discussed in detail in Chapter 5,
Recovering. You can choose the volume to recover and the tape to
recover it from.
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Starting the Replica Application

The Replica Windows interface makes it easy for you to protect your
data. You can set up and schedule replication jobs, recover volumes,
access files on tape, manage your tape databases and set up tape
rotations, even monitor the progress of jobs.

To start Replica at any Administrative PC

1. From the Start Menu program group, choose REPLICA.

2. Choose the Host Replica Server from the list and log in.

� The toolbar gives you access to Replica functions: Replicate,
Recover, Mount Tape, Status, and Utilities. You can also open the
online Help or exit Replica.

� The network list lets you choose what to back up or recover.
Partition Data and Non-NetWare Partitions are available only when
Replica supports Disaster Recovery.

Toolbar

Network list -

(Not all objects

are available

for the Backup

version)

Status bar
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Selecting Objects

The Replicate, Recover, and Mount Tape functions let you use the
network list to select network objects such as security or volumes for
processing.

The network list shows the Host Replica Server that you logged into
when starting Replica.

� For replicating (backing up) objects, you can choose any volumes
or security. You can click the entire server (which selects all its
objects) or any set of objects to replicate. See Chapter 3,
Replicating, for details.

� For choosing an object to recover, all objects that have been
replicated on the current Host Replica Server are available. See
Chapter 5, Recovering, for details.

When the list first appears in the Replicate window, the current Host
Replica Server is opened and all its components are selected; these are
the server’s storage management objects. Each object is indicated by an
icon. A check indicates the currently selected objects. You expand and
collapse objects in the network list by clicking on the and symbols.

Icon ... Indicates ....

Network

Server

Partition data

Non-NetWare partitions

NDS or Bindery

Volume (mounted or unmounted)

Free space not yet assigned to a volume

Tape (appears in Recover lists only)

Tape that does hardware compression
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Replica Functions

When you choose any Replica operation from the toolbar or Operation
menu, the resulting window contains tabs that give you immediate access
to additional information.

They are covered in detail in chapters 3 through 6.

REPLICATE

Replica can back up a complete NetWare file server to a tape device
attached to that server. If you have the Backup version, you get all the
NetWare volumes and the Security. If you have the Single Server version,
Replica also backs up the boot and partition information, NetWare and
non-NetWare volumes, and NDS or Bindery. You can use a full server
replication tape for disaster recovery (Single Server version only),
volume recovery, or file recovery. Replica can also backup individual
NetWare volumes or security to tape.

Replica can copy a single disk volume to free space or a disk volume on
the Host Replica Server, so it can be available immediately in case of
emergency.

You can schedule replication jobs and specify how Replica should
handle the volumes during the process. For example, you can let Replica
process a volume, including protecting open files, while the disk is in
use and tell it to automatically mount a volume from the tape when it is
finished.

Chapter 3, Replicating, explains how to use the Replication process.

RECOVER

Replica can recover any  server object from tape. Just choose the backed
up object and the tape it is on.

Chapter 5, Recovering, explains how to recover volumes or security
from the Administrative PC.
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MOUNT TAPE

You use any replication tape to recover files from any replicated volume.
You can even let users access their own replicated files. Just tell Replica
to mount a volume on a replication tape as a read-only NetWare volume.
The volume retains the same access rights as the original, so valid users
can access, recover, even execute any file.

Chapter 5, Recovering, explains how to recover individual directories
and files.

STATUS

You can monitor any device queue, see the status and progress of any
job, rearrange jobs in the queue, and see the listing of past Replica job
and error messages.

Chapter 6, Status, explains how to use the Replica Status window.

UTILITIES

Replica provides utilities to help you manage your tapes and tape
devices, as well as keep the tape databases on the Host Replica Server up
to date. If you have the Single Server version, another utility creates
Disaster Recovery disks for you if you need them. Many HP tape devices
support HP One-Button Disaster Recovery, which doesn’t require disks.

Chapter 7, Utilities, explains how to use Replica utilities.

Preferences

You can set preferences from the File menu to control which Replica
window appears when you open Replica and how often you must enter a
server password while using Replica.
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When you choose Preferences from the File menu, you see this dialog:

Window Preferences

On the Window tab, you can control how Replica operation windows
look and act.

To ... Use this field ....

Display or hide the toolbar Show Toolbar

Show information about a displayed
tool when your pointer rests on it

Show Tooltips

Display or hide the status bar Show status bar

Include the date in the status bar Date

Include the time in the status bar Time

Specify the initial window Startup window

When you first install Replica, it is set to display the Replicate window
whenever Replica starts. Later on, you may want to start with the Status
window, for example, to see how jobs are going.
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To change the initial window

1. On the File menu, choose Preferences.

2. On the Window tab, open the Startup window drop-

down list.

3. Choose the window you want to see.

 You can choose from Replicate, Recover, Mount Tape,

Status, Utilities, Last, and None.

Security Preferences

This feature is not available in this version of Replica. In some Replica
versions, you can ask Replica to require a password whenever you
change to a different Host Server or access a different server. By default,
Replica remembers passwords. While Replica is open; it doesn’t ask for
a password again for that server within the Replica session.



Replicating your data makes it possible to recover security, individual
volumes, and individual files and directories. You can replicate data by
using the Backup icon to run the job defined by the Backup
Configuration Wizard or use the Replica program to define additional
backup jobs. This chapter explains the details. This page gives the
essentials of replication.

Replicating a server or some of
its components See page ...

1. Start Replica.

2. Click REPLICATE.

3. Choose the objects to replicate. 30

4. Schedule the job; run it

immediately or specify the interval.
31

5. Choose the tape or disk to hold the

replicated object.
34

6. Change the options, if necessary. 36

7. Start the job or submit it to the

queue.
39

Replica can recover individual volumes from full server or volume
backup tapes. It also lets you recover individual files from any backup
tape. Chapter 5, Recovery, includes the details. Chapter 4, Disaster
Recovery, shows how to do Disaster Recovery using HP One-Button
Disaster Recovery or the standard Disaster Recovery method.

To configure or modify your default backup job, use the Backup
Configuration Wizard. You can use the Replica Backup icon from your
desktop to run this job immedidately rather than waiting for the
scheduled time.
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What is Replication?

Replica uses Object Replication Technology to make a logical copy of
the source object on a destination tape or disk volume. It captures all
blocks that contain data and places them unchanged on the destination.
Replica doesn’t have to look at attributes, file name, or file type; it
captures everything.

You replicate data so that you can recover it if necessary. Replica can
recover data in several ways:

� Disaster recovery. If you have the Single Server version and use
Replica to protect the full server, you can use Disaster Recovery to
recover it.

� Volume or security recovery. If you use Replica to replicate the
full server or the individual object to tape, you can use Replica to
recover it.

� File or directory recovery. Whether you replicated the full server
or an individual volume to tape, Replica can mount the tape and
gain access to individual files, multiple files, even full directories.

Replica can also create a new copy of a volume on the Host Replica
Server.

If you choose ... Replica …

An existing disk volume Overwrites any previous data on the
disk

Free space on the disk Creates a disk volume with the name
you specify

When you choose what to replicate, Replica decides what destination
media are available to you. If you have the Single Server version, Replica
may select additional components that will make disaster recovery
possible.
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Selecting ... also selects ... to...

Server all components tape

All components server tape

Partition data SYS, NDS, and non-NetWare
partitions

tape

Non-NetWare partition SYS, NDS, and partition data tape

NDS  or Bindery tape/ disk

One volume tape/ disk

Multiple volumes tape

If you have the Single Server version, Disaster Recovery is possible if
your backup includes partition data, security, non-NetWare partition,
and the SYS volume.

Using Backup Configuration Wizard

Replica for HP SureStore Tape provides an easy way to configure or
change your default backup job. The Wizard is self-explanatory. This
section explains some effects and limitations.

To run the Backup Configuration Wizard

1. Choose it from the Desktop or the Replica group on the

Start Menu.

2. Choose the server and log in.

 You can choose from all NetWare servers on your

network that have Replica for HP SureStore Tape

installed.

3. Confirm the tape device to use.

 The default job always uses your primary supported HP

tape device. You can use the Replica application to send

jobs to this device as well as to other supported devices.
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4. Choose the objects to back up.

 The Wizard won’t let you choose more than it estimates

will fit on the tape in compressed form. Replica will warn

you if the data might overfill the tape. (If you have the

Single Server version and want to be able to do Disaster

Recovery from the tape, choose Partition Data and

Replica will select any other required components.)

5. Choose the schedule for the backups.

 You can use the Backup desktop icon to run this job

immediately whenever you want. It will also run on the

schedule you set.

6. Click Finish when you see the Backup Summary.

This job differs from backups you create using the standard Replica
application in several ways.

� It uses only the primary supported tape device. You can choose
from all installed supported devices in the Replicate Destination tab.

� It always overwrites data on the tape, so each default job uses the
whole tape. You can choose to append data to a replication tape in
the Replicate Options tab.

Using REPLICATE
To set up a replication job through the Replica application, you have to
tell Replica what to replicate, when to run the job, where to store the
replicated objects, and what option settings to use if you don’t want the
defaults.

If you set a schedule for a replication job, it will run on that schedule
until you change the schedule or delete the job from the queue. Every
replication for a scheduled job is done the same. Daily and weekly
replications are identical; the only difference is when tapes are
scheduled to be reused.

By default, Replica processes the selected items immediately, using the
tape you specify (or the first one in its list) as the destination. You can
use the Options tab to control whether Replica overwrites or appends
data to the tapes, whether it checks tape labels, whether it verifies data
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written to tape, how it handles volumes during replication, and whether
it should process any special commands before or after replication. See
page 36 for information on setting the options.

7/24 Live Server Replication

By default, Replica backs up data while the server is in use, working with
a flexible cache so it can back up open files. If the server has
exceptionally heavy usage, Replica may not be able handle all the
caching needed. In that case, you may want to choose one of the other
options.

You can choose Limited live server replication, in which the server
stays live unless and until the cache overflows. At that point, user access
is partially suspended until the replication is complete. Access is
restored automatically.

For the very quickest replication and lowest memory usage, you can
choose Dismount volume before replication. Then Replica
dismounts each volume in turn, backs it up, and mounts it again.

Additional Replication Job Processing

Suppose you want additional actions taken before or after a replication
job. The Replica options let you specify processing.

� Before the job, Replica can run a NetWare NCF file.

� After the job, Replica can automatically mount a volume on the
resulting tape on the server and/or run a NetWare NCF file.

NetWare NCF File
You may want additional processing before or after a replication job.
For example, you may want to:

� Close a particularly active database.

� Dismount or mount a particular volume on a server before
replication begins.

� Unload or reload an NLM that uses a great deal of server memory.

� Unload or reload a different backup application.
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You can create an NCF file containing the commands you want executed;
an NCF file is equivalent to a batch file and is run at the NetWare console.
Use NetWare standard 8.3 file names and store any NCF files you create
for Replica in the SYS:System directory.

When creating the Replica backup job, you can tell Replica to process
the file just before or just after replicating the data. By default, Replica
starts processing NCF files one minute before or after the job. You can
change the timing in the replica.ini file. It contains these lines:

PreNCFRunTime=1 (runs NCF file one minute before job)

PostNCFRunTime=1 (runs NCF file one minute after job)

You can specify a larger number to start the NCF file a larger number of
minutes before the Replica job starts or ends. The value you specify in
the replica.ini file applies to all Replica jobs.

Automatic Mounting of Tapes

Replica can automatically mount a volume from a replication tape as a
read-only NetWare volume as soon as the job is complete. You can use
Replica Restore or choose MOUNT to mount a volume later. In either
case, you or your users can access the mounted volume directly through
Network Neighborhood or use any utility to map a drive letter to the
mounted tape.

You choose the automatic mounting option and name the volume to be
mounted when you schedule the job. Chapter 5, Recovering, explains
how to use the MOUNT operation.

Automatic Dismounting of Tapes
Of course, only one job can use a given tape device at a time. By default,
Replica automatically dismounts any mounted tape in the device before
starting the replication. Replica will follow your other instructions to
overwrite or append data to the tape.
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The Replicate Window

When you first start Replica, the Replicate window appears by default. If
it isn’t displayed, click the REPLICATE button on the toolbar. The Host
Replica Server field at the top of the window shows the current server.
To change to a different server, exit Replica and restart it. You’ll be able
to log on to any NetWare server that has Replica for HP SureStore Tape
installed.

The Replicate window has four tabs (Source, Schedule, Destination, and
Options) to make it easy for you to prepare, submit, and administer
replication jobs and devices.

Replication Scenario

Suppose you want to replicate your server now so that you can restore
any volume or any specific file. If you have the Single Server version,
you’d like to use the tape for disaster recovery.

What you do:

1. Make sure the tape you want to use is in the device.

If you have the Backup

version, you won’t be

able to choose all

these objects.
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2. Start Replica at the Administrative PC. Log into a Host

Replica Server.

3. If necessary, click REPLICATE on the toolbar.

4. On the Source tab in the network list, make sure the

server is checked.

5. If you want to replicate deleted files, check Include
deleted files.

6. On the Destination tab, choose a tape device in the

Target Drives list.

7. Click a tape name from the Tape Library list, or click

New Tape and label a new one.

8. Click Start, then enter a Job Name when asked.

What Replica does:

1. Asks for a job name and description so you can identify

the job.

2. Begins replicating the server, using the tape you

specified and any default options.

 By default, Replica uses 7/24 Live Server Replication to

allow full server access during the process with no open

file errors. You don’t have to close files or log off.

3. Opens the Status window so you can see the job’s

progress.

Choosing the Source

The Replicate Source tab lets you specify what to replicate. You can
choose any or all objects on a single server.

� Choose the objects to replicate from the network list. What you
choose here determines how Replica works and what you can
recover. For full disaster recovery potential, choose the server itself.
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� See the System information pane on the right for details.

� To conserve tape space, leave Include deleted files unchecked.

To ... Do this ....

Select a second object to replicate Click the next object.

Clear (uncheck) an object Click the object.

See how large the replication will
be or how long it will take

Examine the values in the
System information pane.

Protect data in files that may have
been deleted

Check Include deleted files.

Minimize the size of the
replication result

Leave Include deleted files
unchecked.

Replicate data to disk Select a single volume on a
server and choose a disk volume
or free space as the destination.

(Single Server version only)
Prepare for full disaster recovery
and allow for any other type of
recovery as well.

Select the server itself.
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Choosing the Schedule

The Replicate Schedule tab lets you specify when to run the replication
job. The default is immediately; the job will start as soon as the device is
available.

Scheduled jobs run repeatedly on the schedule you specify. If you
schedule a job that you want run just once, be sure to use the Replica
Status window to delete it from the queue after it is completed.
Chapter 6, Status, includes full details.

� Choose Immediate (default) or Scheduled.

� When you select Scheduled, the Schedule method pane appears.

� Choose Daily, Weekly, or None for each day. Each job can
include only one Weekly tape. What you choose determines how
tapes are rotated: Daily tapes are reused every week, while
Weekly tapes are reused at the interval you choose. Replica
handles the labeling of tapes for you.

� Choose the time to run the job. Set the rotation period for
weekly tapes.
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To ... Do this ...

Run the job now Click Immediate.

Replicate the source only
once a week

Click Scheduled. Then choose
Weekly for the day you want and
None for all the others.

Replicate the source every
day at 4 AM, including
weekends, saving the
Saturday tapes for six weeks.

Click Scheduled. Choose Weekly for
Saturday and Daily for every other
day. Change the time to 4 AM. Change
the Reuse weekly tapes field to 6.

Replicate a server twice a
day, at 9 AM and 9 PM.

Schedule two separate jobs through
Replica, one for each time.

Scheduling Jobs in 12-hour Time

Replica for NetWare uses 12-hour time for scheduling jobs. If your
Administrative PC uses 24 hour time, change it to 12-hour time.

To change to 12-hour time

1. Open the Regional Settings icon in the Control Panel.

2. On the Time tab, change the uppercase "H" in the Time

style field to lowercase "h".

Tape Labels

If you choose Scheduled, Replica creates a tape label in the form
“jobname_scheduled” to use each time it runs the job. The label for a
job named DBvolume scheduled to run on Thursdays would be
“DBvolume_THURSDAY”. A weekly job with a rotation of two weeks
would have tape labels of “DBvolume_WEEKLY1” and
“DBvolume_WEEKLY2” in alternate weeks.

Replica expects you to make sure the correct tape is available in the
device before each job runs. However, you can have Replica verify that
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the correct tape is in the device. See Choosing Options on page 36 for
details.

If you choose Immediate, you can choose an existing tape as labeled or
relabel the current tape by clicking the New Tape button on the
Destination tab. If there is no label, Replica creates one in the format
REPLICA date time.

Note: The job you configure using the Wizard starts with  the tape
label “Backup Wizard” with a special character at the beginning and
end. Scheduled Wizard jobs include the day of the week as part of the
label.

Replication Queues

When you schedule a job, Replica adds it to the queue waiting for the
destination device. If the device is free when the scheduled time arrives
(or immediately), the job begins. If the device is currently in use by
another job, your job waits until it is available. You can ask Replica (on
the Options tab) to automatically dismount a tape mounted as a NetWare
volume, but you can’t bypass any other recovery, replication, or utility
jobs, although you may be able to cancel them.

Replica lets you control jobs in the queue for any device. Chapter 6,
Status, includes full details.

Choosing the Destination

The Replicate Destination tab lets you specify the device where the
selected source object is sent. You can choose any supported device. For
an immediate job, you can choose a tape listed for that device or relabel
the current tape. If the source is a single volume, you can choose free
space or any available disk volume on the Host Replica Server.

The Source and Schedule determine what appears on the Replicate
Destination tab.
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Note: The symbol in the tape name represents a special internal
character that tells Replica this is a Wizard job.

� The Target Drives list shows the available tape devices. If a single
volume is selected on the Source tab, the list includes disk volumes
and free space on the Host Replica Server that are at least as large
as the source volume. You won’t be able to select the SYS volume as
a destination, because that volume is in use. Any existing data on a
destination tape volume is lost if Overwrite (the default) is selected
on the Options tab; existing data on a destination disk volume is
always lost.

� If you choose Free Space, Replica asks you for a name and creates a
volume from the free space before it starts the job. If you choose a
mounted disk volume, Replica asks if you want to overwrite it, then
dismounts the volume before replicating to it.

� If you select the tape drive and this is an Immediate job, you can
choose an appropriate tape from the database or create (label) a
new tape for the database. Of course, you’ll have to make sure the
tape is available in the device when the job runs. Click any column
head to sort the tapes by that field. Resize the columns by dragging
the vertical lines that divide the column heads.
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To ... Do this ...

Select a disk volume as the
target drive

Make sure a single volume is
selected on the Source tab, then
select a disk in the Target drives list
on the Destination tab.

Choose a specific tape for a
replication

Make sure the Schedule tab shows
Immediate. Then on the Destination
tab, select a tape drive, and choose
the tape from the list.

Force Replica to start at the
beginning of the tape

On the Options tab, make sure
Overwrite is selected. Verify tape
labels prevents the job from
running if the wrong tape is in the
drive.

Relabel the current tape
(you won’t be able access any
previous data)

While preparing an Immediate job,
click .

Choosing Options

The Replicate Options tab lets you control features related to the job and
its destination. They apply to all replication jobs you create until you
change the options.

Server Access

Replica defaults to 7/24 Live Server Replication, which allows users
read and write access to server volumes during replication. It backs up
data as it is at the time replication begins, caching changes as needed.
This method requires an additional control block at the end of the tape.

� For quicker tape mounting for file recovery, choose Limited live
server access instead. If the write buffers are filled with this
method, Replica suspends access until the job is complete.
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� For ever quicker tape mounting, choose Dismount volume
before replicating; this also requires less memory than either
other access option.

Tapes produced using either Limited live server access or
Dismount volume mount more quickly because they store file and
directory information at the beginning of the tape.

Additional Job Processing
You can specify additional processing to take place before or after
Replica runs a replication job.

To have Replica … Check …

Mount a volume on this tape after
the job completes

Mount tape after replication
and choose the volume name.

Process NetWare NCF file before
replication

Run NetWare NCF file and type
the filename in the Before field

Process NetWare NCF file after
replication

Run NetWare NCF file and type
the filename in the After field
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Tape Options

The Options tab also lets you control how Replica handles tapes as it
replicates data. By default, it overwrites data, starting at the beginning of
the current tape for each job; Overwrite is on and Append is off. If you
check Verify tape labels, Replica won’t overwrite or append data
when the current label does not match the one assigned to the job, so
the job may not run successfully.

If the current tape device supports HP One-Button Disaster Recovery, the
Write One-Button D/R session field is visible. It is checked whenever
Overwrite is selected and the replication job is capable of disaster
recovery. If Partition Data is not selected for backup or if Append is
selected, the field is not available.

To have Replica ... Do this ...

Verify that the replicated data is
readable

Check Verify replication.

Physically unload the tape Check Eject tape after
replication.

Start at the beginning of the
current tape and label it

Select Overwrite and uncheck
Verify tape labels.

Start at the beginning of the tape
you specify

Select Overwrite and check
Verify tape labels.

Omit the HP One-Button Disaster
Recovery information from the
tape (you would do so only if your
system doesn’t support OBDR)

Uncheck Write One-Button
D/R session. (Checked by
default when Overwrite is
selected and the job supports it)

Append jobs to the end of the
current tape

Select Append and uncheck
Verify tape labels.

Append jobs to the end of the tape
you selected

Select Append and check
Verify tape labels.
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Submitting the Replication Job

The Replicate window includes one of three buttons:

If you chose ... You’ll see ...

Immediate on the Schedule tab  

Scheduled on the Schedule tab

Edit in the Status window

After you submit a job, Replica opens the Status window so you can see
your job’s progress in the device queue.

Every replication job creates a Backup Report (SUMMARY.TXT) in your
LOGFILES directory (a subdirectory of the system\replica folder on the
server). This report shows the job name and details what objects are
backed up and the whether they completed successfully. This file is
replaced for every replication job.

The Replica History log gives you full information about the job’s
progress. If you aren’t sure if a job started or ran correctly, check the
History tab in the Status window and read the messages related to that
job. Chapter 6, Status, includes the details.

Replication Examples

This section shows examples of five replication jobs.

� Running the default job

 Shows how to run your scheduled default job immediately

� Full replication
 Shows how to specify a comprehensive replication that lets you

recover the entire server, volumes, and files

� Replicating volumes to tape
 Shows how to specify a replication that allows you to recover

volumes or files
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� Replicating one volume to disk
 Shows how to replicate data to a disk volume that can be mounted

when needed.

� Multiple-job replication system
 Shows how to design a schedule with different types of replications.

Running the Default Job

Suppose you have a job scheduled through the Backup Configuration
Wizard, but you want to run it an extra time—right now.

How to do it

1. Make sure the tape you want to use is inserted into the

drive.

2. Click Replica Backup on the desktop.

3. Examine the Status window, or close Replica.

What happens in Replica

� Replica starts backing up the objects specified in the job.

� Replica opens a Status window so you can see this job’s progress in
the queue. Chapter 6, Status, includes information on the Status
window.

Full Replication

Suppose you have to be prepared for any crisis. Every day you want a
complete replication that you can use to recover everything possible in
the event of a disaster. You also want to be able to recover individual
volumes and files as needed. You want one replication each week kept
for several weeks. Other tapes can be reused weekly.

You’ll accept most of the default options, but you want DOFIRST.NCF
processed just before the job begins.
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How to do it

1. Start Replica.

2. Click REPLICATE, if necessary, to open the Replica

window.

3. On the Source tab, choose the server.

4. On the Schedule tab, set one day to Weekly and the rest

to Daily.

5. On the Destination tab, choose the destination device, if

necessary.

6. On the Options tab, check Run NetWare NCF file and

type DOFIRST.NCF in the Before: field.

7. Click Submit and enter a job name.

What happens in Replica

� Replica asks for a job name so you can recognize your job in status
reports.

� Replica opens a Status window so you can see job’s progress in the
queue. Chapter 6, Status, includes full information on the Status
window.

� At the appropriate time, Replica sends data to the destination tape.

Using the replicated server tape

� If you have the Single Server version, recover the entire server from
a disaster. See Chapter 4, Disaster Recovery, for details.

� Recover security or any volume from the server using Replica
Recover. See Chapter 5, Recovering, for details.

� Access any individual file after Replica mounts the tape. See
Chapter 5, Recovering, for details.

Replicating Volumes to Tape

Suppose you want several of your server volumes backed up to tape for
safe offsite storage.
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How to do it

1. Start Replica.

2. Click REPLICATE, if necessary, to open the Replica

window.

3. Choose the volumes you want replicated as the source.

 You can also choose the NDS or Bindery security object.

4. Choose Immediate or set the schedule.

 Make sure the right tape is inserted before each job

begins.

5. Choose the current tape as the destination.

6. Click Start or Submit and enter a job name when asked.

What happens in Replica

� Replica asks for a job name so you can recognize your job in status
reports.

� Replica opens a Status window so you can see this job’s progress in
the queue. Chapter 6, Status, includes information on the Status
window.

� At the appropriate time, Replica sends data to the destination tape.

Using the volume replication tape

� Recover any volume on the server from the tape using Replica
Recover. Chapter 5, Recovering, includes the details.

� Access any file after Replica mounts the tape. Chapter 5,
Recovering, includes the details.

Replicating One Volume to Disk

Recovering volumes from tape, even with a high-speed system such as
Replica, takes time. Users may need immediate access to their data, even
when a server is in trouble. Replica can copy a server volume to a disk
(volume or free space) located on the Host Replica Server, where it is
available immediately.
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You’ll have to process each volume individually.

How to do it

1. Start Replica.

2. Click REPLICATE, if necessary, to open the Replicate

window.

3. Choose the volume you want replicated as the source.

4. Choose Immediate or set the schedule.

5. Choose one of the available disk volumes or free space

as the destination.

 Replica lists all disk volumes and free space that are at

least as large as the source volume. If you choose a

mounted volume, Replica dismounts it before replicating

data. If you choose free space, Replica creates a volume

the same size as the source volume.

6. Click Start or Submit and enter a job name when asked.

What happens in Replica

� Replica asks for a job name so you can recognize the job in
messages and reports.

� Replica opens a Status window so you can see this job’s progress in
the queue. Chapter 6, Status, includes full information on the Status
window.

� At the appropriate time, Replica dismounts the destination disk,  if
necessary, and writes data to it.

Using the replicated disk

� Mount it and access data just as with any other NetWare volume.

Multiple-Job Replication

Suppose your replication needs are more complex. You want a full
replication on Saturday morning at 5 a.m. Every weekday at 6 p.m., you
want the SYS volume and two of your server’s data volumes replicated to
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disk for quick access. And every weekday at 5 a.m. you want a third data
volume (named CUSTS)replicated to tape and automatically mounted
after it is ready. You submit five separate jobs that automatically protect
your data the way you want.

Job 1: Full replication

1. Choose the server as the source.

2. Schedule Weekly for Saturday and set the time at 5 a.m.

Choose None for each other day.

3. Click Submit and enter a job name when asked.

Jobs 2, 3, and 4: Daily replications to disk

1. For the source, choose SYS or a data volume.

2. Schedule Daily for Mon, Tues, Wed, Thurs, and Fri.

Choose None for each other day. Set the time at 6 p.m.

3. Select the appropriate disk for the destination.

4. Click Submit and enter a job name when asked.

5. Do the same for the other volumes.

Jobs 5: Daily replication to tape and automatic
mounting

1. For the source, choose the server, then the CUSTS

volume.

2. Schedule Daily for Mon, Tues, Wed, Thurs, and Fri.

Choose None for each other day. Set the time at 5 a.m.

3. Select the appropriate disk for the destination.

4. On the Options tab, check Mount tape volume when
job completes and type CUSTS in the text field.

5. Click Submit and enter a job name when asked.

Replica schedules and runs each job independently. Together, they
produce a protection system that meets your needs.



Replica supports two Disaster Recovery methods. If your tape drive and
system support the latest technology, use HP One-Button Disaster
Recovery (OBDR). Otherwise use standard Replica Disaster Recovery.

Using HP One-Button Disaster Recovery See page

1. Do regular full backups with OBDR

session enabled.

2. To recover, turn off the server and tape

drive, then restart them while pressing

the tape drive’s Eject button.

48

3. Follow the instructions on the screen.

For standard Disaster Recovery, you have to create Disaster Recovery
disks before the disaster occurs, then use them to restart the server.

Creating Disaster Recovery disks See page

1. At the Administrative PC, start Replica.

2. Click UTILITIES, then choose the Disaster

Recovery tab.
49

3. Choose the server and then click Create

Disks.
49

Recovering a Host Replica Server See page

1. Insert the full server replication tape into

the Host Replica Server’s tape drive.

2. Restart the crashed server with its

Disaster Recovery Disk 1; insert other

disks as needed.

50

3. Let Replica recover the Host Replica

Server’s data automatically

IMPORTANT! This

chapter applies only to

the Single Server

version. The Backup

version does not

include Disaster

Recovery.
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The Disaster Recovery Process

Disasters come in many forms. A server disaster may be caused by fire,
flood, hurricane, or earthquake, as well as carelessness and deliberate
sabotage. Disasters can also occur as part of the natural aging process of
hard disk drives and other hardware involved.

Replica can recover your server’s contents after it is corrupted or
destroyed. You can even recover to a new or different server, it it has a
supported HP tape device and if you have a replication tape containing at
least the server’s essential components.

IMPORTANT! After performing any kind of Disaster Recovery,
you will not be able to immediately recover volumes or files from that
job or later jobs on  the same tape. If you find it necessary, you can use
Replica Utilities to Import the tape into the Replica databases. Then
you’ll be able to use the tape as before.

How Replica handles Disaster Recovery depends on the type of tape
drive you have and what your system supports.

� Many HP tape drives support HP One-Button Disaster Recovery
(OBDR). If your system supports it as well, continue with this
section. It shows what you have to do in detail, as well as how to tell
if your system supports this simple, elegant method.

� All HP tape drives support standard Replica Disaster Recovery. The
following section (see page 49) shows how to prepare for and use
that method.

IMPORTANT! On the next page, you’ll see how to tell if your tape
device and system support HP One-Button Disaster Recovery. If you are
still not sure, create a set of standard Replica Disaster Recovery disks
as described on page 49 to ensure you will be able to recover your
server in case of a disaster.
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HP One-Button Disaster Recovery

This is the most convenient way to recover a server.

To prepare for disasters:

� Just do regular full backups.

For HP One-Button Disaster Recovery:

� Power down the server and tape drive.
  Internal drive:
� Press tape eject button and turn on server.
� Release the eject button and immediately insert the recovery

tape.
� Follow the directions on the screen.

  External drive:
� Press tape eject button and turn on the tape drive.
� Release the eject button and turn on the server.
� Immediately  insert the recovery tape.
� Follow the directions on the screen.

Does Your Tape Device Support OBDR?

The easiest way to tell if your tape device supports HP One-Button
Disaster Recovery is to check it out in Replica. In the Replicate window,

1. On the Source tab, choose anything.

2. On the Destination tab, choose the tape device.

3. On the Options tab, see if the Write One-Button D/R
session field is available.

 If the field is available, the tape device supports OBDR.

Can Your System Support OBDR?

Some systems are not equipped to handle HP One-Button Disaster
Recovery, even with a supported HP tape drive. They cannot handle a
bootable CD-ROM or a tape drive that can use this feature.
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To tell if your system can use OBDR

1. Create a full backup and leave the tape in the drive. See

Chapter 3, Replicating, for details.

2. Turn the server and the tape drive completely off.

3. Press the tape eject button and turn on the tape drive.

 This causes the tape drive to initialize in OBDR mode.

4. Release the eject button and start the server. Watch the

boot prompts on the screen.

 If the system supports OBDR, it will boot from the tape

drive and NOT from the hard disk.

5. At the first full information screen, you are asked if you

want to continue. You are doing a trial run, so press N.

 This cancels OBDR mode and restores the tape drive to

normal usage.

6. Restart the server normally.

If your system does not support OBDR, use Replica’s standard Disaster
Recovery features. See page 49 for details.

Preparing for HP OBDR

By default, every full backup to a tape drive that supports OBDR includes
the information Replica needs to perform HP One-Button Disaster
Recovery. If you want to turn it off, go to the Replicate Options tab and
uncheck Write One-Button D/R session.

Performing HP One-Button Disaster
Recovery

1. Turn the server and the tape drive completely off.

2. Hold down the eject button on the tape drive while you

restart the server and the tape drive. If you have an

external drive, turn on the tape drive while pressing

eject, then immediately turn on the server.

 This causes the tape drive to start up in OBDR mode.
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3. Insert a recent full backup tape.

 The server will boot from the tape drive and NOT from

the hard disk.

4. Follow the instructions on the screen.

Standard Disaster Recovery

Replica’s standard Disaster Recovery process starts when you use
Replica Disaster Recovery floppy disks to restart the server. Host Replica
Server recovery is automatic. The Disaster Recovery disks start the
process and use the tape in the tape drive.

Preparing for Standard Disaster Recovery

Before you can use the Replica Disaster Recovery process, you must be
prepared with:

� A set of Replica Disaster Recovery floppy disks.

� A complete server replication to tape.
(See Chapter 3, Replicating, for details.)

Creating Disaster Recovery Disks

You create Replica Disaster Recovery disks using the Utilities operation
and the Disaster Recovery tab.

Note: You’ll need two or three floppy disks. Replica will format them
for you.
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To create Disaster Recovery floppy disks

1. Start Replica in Windows.

2. Click UTILITIES in the toolbar.

3. Choose the Disaster Recovery tab.

4. Choose a floppy disk drive.

5. Click Create Disks.

6. Follow the directions on the screen.

Label your floppy disks and store them securely.

IMPORTANT! Recovering a server rebuilds the entire system. Any
existing partition and volume information is destroyed, then recovered
from the tape using the partition data there.

Recovering from a Disaster

When the inevitable occurs, you are ready if you created Disaster
Recovery disks for your server and replicated the entire server regularly.
Replica can do a full disaster recovery to the time of the last full server
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backup. You must recover each server separately, just as you replicated
them separately.

This section shows you how to use Disaster Recovery disks and a full
server tape replication to completely recover a server.

To recover a Host Replica Server

1. Insert the tape containing the replicated data into the

device. Replica uses that tape to recover the server

based on the system data on the tape, including:

� Partition data
� Non-NetWare partitions
� NetWare volumes
� Security (NDS or Bindery)

2. Restart the server using Replica Disaster Recovery Disk 1

at the NetWare console.

3. Insert additional disks when prompted.

That’s all there is to it. You’ll just have to tell Replica to continue.

Note: If the Host Replica Server has a non-NetWare proprietary
utility partition, as Hewlett-Packard and Compaq servers do, Replica
offers to recover it. If you are recovering the same server you backed
up, let Replica recover the partition. If you are recovering to a different
server,  use the manufacturer’s instructions to rebuild the proprietary
partition after Replica is finished.

Standard Disaster Recovery Example

This section shows how to use Disaster Recovery disks and a full Host
Replica Server replication tape to completely recover the server from
disaster.

If you created Disaster Recovery disks and replicated the entire Host
Replica Server regularly, Replica can do a full disaster recovery to the
time of the last full server backup in case of a server disaster. You must
recover each server separately, just as you replicated them separately.
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How to do it

1. Insert the full Host Replica Server replication tape into its

tape drive.

2. Restart the server using Replica Disaster Recovery

Disk 1. Insert additional disks when asked.

3. If necessary, choose which tape drive to use.

Note: You can use the same technique to recover the essential
components of a server from a tape that contains them.

What happens in Replica

� Replica restarts DOS, the NetWare server, and Replica from the
Disaster Recovery disks. Then it uses the current tape.

Replica recovers the server and its volumes to their original locations.



You use Replica to recover servers, volumes, and files. This chapter
explains the details of recovering files and volumes. This page gives the
essentials.

Recovering files or directories See page

1. Click Restore Files or start Replica and

click MOUNT in the toolbar.

2. Choose the or volume and tape. 55

3. Click the Mount button. 56

4. If necessary, map a drive letter to the

volume.

Recovering a volume or security See page

1. Start Replica.

2. Click RECOVER.

3. Choose the object and tape. 58

4. Choose where to recover the data. 59

5. Click Start to recover the volume or

security immediately.
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Recovering Objects

The Replica Recover operation can recover:

� The system volume.

� Any data volume.

� Security (NDS or Bindery)

The Replica Mount operation can recover:

� Any file.

� Any directory on a replicated tape.

You tell Replica what you want to recover by specifying the storage
management object (security or volume) and the tape. Then you tell
Replica where to recover it. If you choose a different location than the
original, it must be at least as large as the original object.

Once you start Recover, Replica opens the Status window so you can see
where the job is in the queue. Chapter 6, Status, explains how to use the
Status window.

Note: Replica completely overwrites security or a volume during
recovery. The previous object is replaced.

The process of recovering individual files from a tape is similar.
However, instead of telling Replica to start Recover, you tell it to Mount a
particular volume on the tape as a NetWare volume. If necessary, you
can map it to a drive letter after the volume is mounted.

Then you or any user can recover individual files or entire directories
from any replicated tape volume that is contained entirely on a single
tape. The mounted tape volume retains the same login security rights as
the original replicated volume.
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Using the Replica Restore Icon

The easiest way to restore files is through the Restore Files desktop icon.
Just click and Replica starts automatically for you to choose a volume for
mounting from the tape in the device. Click Mount Tape and the volume
you selected is mounted for your use through NetWork Neighborhood.

Once Replica is opened, you can use it for any other functions as well.

Recovering Files and Directories

More often than recovering a complete volume, you’ll be asked to help
recover an individual file, a directory, or a collection of files and
directories. Replica provides Direct Media Access technology to make
these recoveries easy. Just tell Replica to mount the tape containing the
data as a NetWare volume.

Note: If the replication job included the Mount tape volume after
replication option, the tape you specified is mounted automatically.

You or any user can access the data needed through NetWork
Neighborhood; you can map a drive letter to the mounted volume if you
want. Replica maintains the volume’s original security rights. If NetWare
doesn’t have enough server memory available for the volume’s cache,
Replica won’t mount the tape as a NetWare volume.
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Note: If you clicked Restore Files on the desktop, the tape in the
drive is selected. Just choose a volume from the network list.

To use Direct Media Access through Replica

1. On the Replica toolbar, click MOUNT.

2. On the Source tab, choose the volume and specify the

tape that contains the data.

 Make sure the tape is inserted in the current device.

3. In the Mount tape field, type the name to be used for

the mounted volume. Replica adds a caret (^) at the

beginning of the name you supply.

4. Click the Mount button.

 The button name changes to Dismount. When mounting

is complete, you can access files on the volume through

Network Neighborhood.

5. You can map a drive letter to the volume using Windows

Explorer or another utility. Use any application to access

the files you want from the read-only volume.

To check the Status of the tape volume

1. Choose the Status tab on the Mount Tape window.

 The Mount Status field changes to Mounted when the

volume is ready.

2. Use the Status window for more information.

Note: The Status tab affects this mounted tape only until you close
the Mount Tape window or end your Replica session. After that, use the
Status window to dismount the tape.

Accessing the Mounted Tape

Users at any PC can access data from the read-only tape volume. They
can copy files, even entire directories to their hard disks or other
network locations. They can even view files or execute programs directly
from the tape. The same NetWare security that applied to the original
replicated volume applies to the mounted tape.

Any network user

can do this
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In Windows 95 you can access the mounted tape volume directly
through Network Neighborhood without mapping it.

Note: Replica includes a special console NetWare command you can
use for efficient copying of files from the mounted tape. Directions for
using REPCOPY are included in Chapter 8, Console Operations.

Recovering a Volume

Volumes are available in the Recover server list if they have been
previously replicated to the current Host Replica Server; you can’t use
Replica to recover data that it didn’t process. To recover data to a Host
Replica Server from a tape replicated on a different Host Replica Server,
first import the tape into the database using the Replica Device utility.
Chapter 7 includes the details.

IMPORTANT! To recover the SYS volume to its original location,
you’ll have to work at the NetWare console. See “Recovering the SYS
Volume” in Chapter 8, Console Operations, for details.

To recover a volume

1. Start Replica and click RECOVER.

2. On the Source tab, choose the object to recover.

3. Choose the tape that contains the replicated object.

 Make sure the tape is in the device. Replica won’t start

recovery unless the tape you selected is available when

you start.

4. On the Destination tab, choose the destination.

 It need not be the same as the original.

5. Click Start.

What happens in Replica

� Replica opens the Status window.

� When the device is available, Replica starts the recovery.
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� If the tape you selected is not loaded, Replica cannot recover the
volume. Check the History tab in the Status window to see if the job
completed successfully. Chapter 6, Status, has the details.

Choosing the Source

You choose what to recover on the Source tab. You can choose any
listed object, such as a NetWare volume or NetWare security (NDS or
Bindery).

After you choose an object to recover, Replica checks its tape database
and lists all the tapes that include a replication of the selected object.
Highlight the tape from which you want Replica to recover data before
continuing to the Destination tab. You’ll have to insert that tape before
starting the job.

To ... Do this ....

Recover from a specific server Choose the appropriate Host
Replica Server when logging in.

Recover from a specific tape Choose the object(s) from the
list, and click the tape in the
Tape library list. Load the tape
in the device.
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To ... Do this ....

Recover a server’s security Choose NDS or Bindery. Then
select a tape that contains it and
specify the destination.

If you are sure a specific tape exists but it doesn’t appear in the list, here
are some things you can do to locate it:

� Change to a different Tape device if the data was replicated on a
different supported device.

� Import a tape if data was replicated on a different tape server.
Chapter 7, Utilities, includes details.

� Recover Replica databases if they have been damaged on the
current server. Chapter 9, Troubleshooting, includes details.

Choosing the Destination

You must tell Replica where to put the object being recovered. The
server list on the Destination tab lets you make your choices. You won’t
be able to choose the SYS volume or any volume or free space that is
smaller than the original replicated volume. Once Replica knows the
destination, the size information appears on the screen.
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� Replica recovers the object to the location you specify. It overwrites
any data currently on that volume. If the source includes more than
one data volume, you must recover them to their original locations.

� If you choose a mounted disk volume, Replica dismounts it for the
recovery process, then mounts it again. Disk volumes are
completely overwritten during recovery.

� The SYS volume is not available as a destination. To recover SYS to
its original location, you must work from the NetWare console. See
“Recovering the SYS Volume” in Chapter 8, Console Operations,
for details.

� If you choose free space, the Free Space name field is available.
Replica creates a volume with the unique name you supply, but
doesn’t mount it for you.

To ... Do this ....

Recover a volume or other
server object

Choose the volume as the source,
select the tape, then choose where
to put it on the Destination tab.

Recover a volume to a new
volume created from free space

Choose Free Space as the
destination. Provide a unique name
in the Free Space name field.

Note: If the recovered data was replicated without the Include
deleted files field checked, and you expect to use Salvage to recover
files that are deleted later from the volume, you must use Purge right
after recovery to tell NetWare that previously deleted files are not
available.

Recovery Examples

This section shows examples of recovery jobs.

� Recovering a single file from tape shows how to mount a tape
for use as a NetWare volume.

� Recovering a volume from tape shows how to use a full server
or volume replication tape to recover a volume.
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Recovering a Single File from Tape

A departing employee seriously damaged the company’s support
database (MASSIVE.DB). You need to recover it from last week’s full
server replication.

How to make it available

1. Click Replica Restore on the Desktop.

 OR

 Start Replica and then click MOUNT on the Replica

toolbar.

2. On the Source tab, choose the volume that contains the

file to be recovered.

3. Choose the tape device and tape that contain the

volume.

4. Accept the default volume name or type a new one in the

Mount tape field.

 Replica adds ^ to the beginning of the name; SYS

becomes ^SYS.

5. Click the Mount button.

 When the volume is mounted, you can map the volume

to a drive letter, if necessary, and access the files.

What happens in Replica

� Replica mounts the tape session as a write-protected NetWare
volume and maps it to the drive letter you chose.

� The job appears as Mounting in the Device Status tab of the Status
window. As soon as the volume is ready for access, the status
changes to Mounted. (The status values also appear in the Status
tab of the Mount Tape window.)

� The tape remains available until you tell Replica to dismount it. If
you leave the Mount Tape window open, you can click Dismount
here. Otherwise, open the Status window, select the Mounted job,
and click Dismount to free up the tape device for other jobs.
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What you can do with mounted tape

1. Map any available drive letter to it using any tool.

2. Copy MASSIVE.DB to the volume that needs it.

Recovering a Volume from Tape

Suppose a volume on the server is corrupt. You can recover it from any
tape replication that includes the volume, whether it is a complete server
replication or any other job that included that volume.

How to recover a volume

1. Delete the old or corrupted volume, if necessary.

2. Click RECOVER on the Replica toolbar.

3. Choose the volume on the Source tab.

4. Choose the tape from which to recover it.

5. Choose the location where you want it on the

Destination tab.

6. Click Start to run the recover job.

What happens in Replica

� Replica starts the recovery immediately if the tape device is
available.

� Replica opens a Status window so you can see how this Recovery
job appears in the job list. Chapter 6, Status, includes full
information on the Status window.

� When the data is recovered, the job leaves the job list and appears
in the History log as completed.



Whenever you start or submit a replication or recovery job, Replica
opens the Status window so you can see how the job is progressing. You
can monitor and control the status of Replica jobs at any time. This
chapter explains the details. This page shows the essentials.

Job list for tape device See page 64

1. Start Replica and log into a Host

Replica Server.

2. Click STATUS.

3. Choose the device.

4. Change status or dismount

tape.

Details for current job See page 65

� On the job list screen, click

Progress.

Information on past jobs and
errors

See page

1. Start Replica and log into a Host

Replica Server.

2. Click STATUS.

3. Choose the device.

4. Click the History tab.

      Or

 Click the Error Log tab.

66

68
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Tracking the Jobs

Replica keeps track of its replication and recovery jobs. Replica Status
lets you see where jobs are in each device’s job list. You can also
examine details about the running job or check out the history of jobs
run on any Host Replica Server.

Device Status

Only one job is Active at a time—the replication, recovery, or utility job
currently using the device. You can change the Host Replica Server
field or the Device field to see the status of jobs for a different server or
device. A job with Mounting or Mounted status indicates a tape is being
used for file recovery. When a device is free, a waiting job may run
immediately. Other waiting jobs await the scheduled time. You can put
any waiting job on hold until you are ready.

IMPORTANT! If a job is scheduled with Dismount tape before
replication checked, any Mounted tape on that device is automatically
dismounted when time comes to run that job. The new job will run
using that tape unless Verify tape labels is checked. Choose Append
to avoid losing data.

The status listing includes some utility jobs, such as Import tape, as well
as replication or recovery jobs started at the server console. Such jobs
are never scheduled, but run as soon as the device is available.

The Device Status tab shows enough information about each job in the
queue so that you can identify it. Jobs remain in the list until they are
completed or removed from the system. The Progress button gives you
information about the Active job.

You can edit any replication jobs that are Waiting or Holding. When
you click Edit, Replica shows you the Replicate window for the selected
job. You can change values on any of the tabs. When you are ready, click
the Resubmit button to place the job back in the queue. If you have
changed the job name, Replica creates a new job; you can delete the
original one if you wish.
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Note: To change  jobs defined through the Backup Configuration
Wizard, run the Wizard again. You can’t edit jobs submitted through
the NetWare console. They always run immediately.

If the job
status is ... You can use ...

Active

Mounting...

Mounted  or map a drive letter to it.

Listing tape

Testing tape

Scanning media

Waiting , , or 

Holding , , or 

Note: To change a recovery job, delete it, then set up a new recovery
operation.

The message in the status bar in the window always shows the current
operation, Replicating VOL1 in this example.
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Progress

You can get more information on the active replication or recovery job
by clicking the Progress button.

Click Job List to return to the Device Status job list.

History

Replica maintains a file (REPLICA.LOG) in the Replica directory on the
SYS volume of each server. This file contains messages, including the
start and stop time, of jobs processed through the Replica application or
at the NetWare console. The History tab displays REPLICA.LOG so you
can see the progress, past or present, of jobs.

You can track replication and recovery jobs, as well as utilities. You’ll
see messages about tape label changes, mounting tapes, erasing tapes,
and importing tapes, as well as testing, listing, or scanning tapes.

The history log accumulates until you delete it. You can’t edit the log or
delete individual entries through Replica. The Print command on the File
menu lets you print or save the file.

Note: As REPLICA.LOG gets larger, it requires more NetWare
resources to transfer the data to the Administrative PC. Deleting the
History frees up the resources for other uses.
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To ... Do this ...

Save the history log information Rename REPLICA.LOG in
Sys\Replica\Logfile on the server.

Print the history log Choose Print from the File menu.

Clear the server history log

What’s in the History Log?
In the history log, you’ll find details on every job run on the Host Replica
Server. For example, this set of messages resulted from an immediate
backup of the SYS volume:

 5-17-97   12:33:25 pm   Initializing Replica...
 5-17-97   12:34:03 pm   Command Line Options are Now Operational
 5-17-97   12:47:51 pm   Begin Processing of Job "Morning SYS".
 5-17-97   12:47:51 pm   Reading: Current Tape
 5-17-97   12:48:00 pm   Mounting Tape: Daily SYS #1
 5-17-97   12:48:05 pm   Labeling Tape: Daily SYS #1
 5-17-97   12:48:34 pm   Analyzing Volume SYS
 5-17-97   12:48:36 pm   Open Session: NetWare Volume SYS
 5-17-97   12:48:36 pm   Replicating SYS:
 5-17-97   12:52:58 pm   Open Session: Replica Database Files
 5-17-97   12:52:59 pm   Replicating Replica Database Files:
 5-17-97   12:53:06 pm   Replica Process Completed Successfully.
 5-17-97   12:53:06 pm   Dismounting Tape: Daily SYS #1
 5-17-97   12:53:06 pm   Total MBytes Processed 68.8

Tip! The History log is your primary tool for troubleshooting Replica.
It indicates whether or not jobs complete successfully.
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Error Log
Replica maintains ERROR.LOG in the Replica\Logfile directory on the
SYS volume of each server. This file contains error messages that Replica
has sent to the NetWare console; it may also contain messages generated
by commands such as REPLICA STOP ACTIVITY. The Error Log tab
displays the messages and lets you print or delete the file.

To ... Do this ...

Save the error log information Rename ERROR.LOG in
Sys\Replica\Logfile on the server.

Print the error log Choose Print from the File menu.

Clear the error log

The error log contains error messages sent by REPLICA.NLM; many of
these also appear in the history. It does not contain NetWare messages.

Note: As ERROR.LOG gets larger, it requires more NetWare resources
to transfer the data to the Administrative PC. Deleting the Error Log
frees up the resources for other uses.

If you have TapeAlert-supported hardware and HP OpenView installed,
you’ll see SNMP messages at the management console.



The Replica utilities help you manage the tapes in use and control your
tape devices. This chapter explains the details. This page gives the
essentials.

Managing Replica tapes See page 70

1. Start Replica and click UTILITIES.

2. Choose the Device tab and select the

device.

3. Select the tape and click Eject, Erase,

Label, Retension, or Import Tape.

Managing the tape database See page 72

1. Start Replica if necessary.

2. Click UTILITIES, then choose the Tape

Database tab.

3. Select a device and tape, then click

Delete or Details.

Single Server version only, without OBDR support

Creating Disaster Recovery Disks See page 74

1. Click UTILITIES, then choose the

Disaster Recovery tab.

2. Click Create Disks.

3. See Chapter 4, Disaster Recovery, for

full details.
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Replica Utilities

Replica provides several utilities that make it easy to maintain your
system. You can manage Replica databases and control tapes on tape
drives.

Replica Databases

Replica maintains a set of database files for (and on) each server. It uses
them to maintain information about the server and how it has used
Replica. One database tracks scheduled jobs. Another database keeps
track of tapes, so Replica knows what tapes are available, their names,
what is stored on each, when it was placed there, even how much each
tape has been used. Replica maintains server information, so it knows at
all times what parts of the server have been replicated and what jobs are
stored on each replication tape. In addition, it knows what recovery has
been done and what utilities have been run.

Replica saves all the current databases for that server as part of each
replication job. So each replication includes the Replica databases for
the entire server as they were at the time the job was run.

If the databases on the server are damaged, Replica lets you recover
them from tape at the NetWare console. See Chapter 9,
Troubleshooting, for more information on recovering databases.

Managing Tapes
Replica automatically handles labeling of tapes for scheduled jobs. You
can modify default labels for immediate jobs. Modifying the label on a
tape makes any data that was on the tape unavailable and removes the
old label from the tape database.

Changing tape labels

• You can label the current tape, whether it is old or new, from the
Utilities Device tab.

• When preparing an immediate job, you can choose New Tape on
the Replicate Destination tab to relabel the current tape.
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Changing tapes in the database
� Labeling a tape adds it to the tape database. If the tape was in the

database under its former name, that entry is removed.

� You can add a tape label to the database by importing the tape
through the Utilities Device tab (Import Tape button).

� To remove a tape from the Replica tape database, delete it through
the Utilities Tape Databases tab (Delete button).

Tape rotation
• You set your schedule and rotation through the Replicate Schedule

tab. Each replication from the same scheduled job is done exactly
the same way.

• There is no difference between a Daily and Weekly replication
except for the tape label and the rotation plan. The latest tape
created contains your latest data.

Device
The Device tab lets you manage tape devices attached to the current Host
Replica Server and all tapes for those devices.

The SCSI ID field shows the current tape drive. If you have more than
one tape device, you can choose another.
The Current Tape field shows the name of the tape currently inserted
in the current tape drive.
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The buttons let you get information and perform operations on the
current tape. The Status fields tell you about the operation in progress.

� Operation shows which task is currently running on the device or
was most recently completed. It shows replication and recovery
operations at the console as well.

� Progress shows how much of the operation is complete for
processes that can be measured.

To ... Use ...

Change or assign a tape label for the current
tape. Labeling a tape erases the previous
contents and the old database entry.

Erase the current tape completely. This also
removes the tape from the database.

Eject the current tape. Replica will dismount
it first, if necessary. Will not be available if
device requires physical eject.

Add the loaded tape (perhaps created on a
different Replica server) to the database on
the current server so it appears in the tape
list. If you have trouble accessing a file from
a tape, import the tape and try again.
Importing the tape replaces any earlier tape
description with "Tape Imported into Replica
System".

Adjust the tape spool tension on a QIC
(Quarter-Inch Cartridge) tape.

Tape Database

Replica maintains a database of tapes used to replicate data on each
device on each server. Each time Replica runs a replication job, it copies
its current databases to the tape so that each tape contains this
information.
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The Tape Database tab lets you examine the tape database on the Host
Replica Server. You can delete any tape no longer in use or get
additional details, including the type of replication and how much the
tape has been used since being entered into the database.

To ... Do this ...

Remove a tape from the
database

Highlight it, then 

See usage information for a tape Highlight it, then 

Print the current tape database Use Print from the File menu.

Remove tapes from the database if they become damaged or lost. If you
remove a tape in error, you can insert the tape into the device, then use
Import Tape on the Device tab to enter it into the tape database again. If
you erase a tape through the Device tab, Replica also removes it from the
tape database.

Note: If the Replica databases become damaged, you can recover
them from any replication tape, using the REPLICA RECOVER
DATABASES command at the NetWare console. Chapter 8, Console
Operations, explains how to use a Replica load option to make this
command available. Chapter 9, Troubleshooting, explains how to
recover the databases.
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Disaster Recovery

Replica Backup for HP SureStore Tape does not support Disaster
Recovery. You’ll see a message about upgrading if you click on the
Disaster Recovery tab. Replica Single Server for HP SureStore Tape
supports two types of Disaster Recovery.

If your tape device and system support  HP One-Button Disaster
Recovery, you won’t ever need Disaster Recovery disks. Just follow the
instructions in Chapter 4 and do regular full backups.

If you need standard Disaster Recovery, however, use this tab to create
the needed Disaster Recovery disks. You use these disks to restart a
server after a disaster strikes. Replica then continues to recover the
entire server using the tape in the current device.

See Chapter 4, Disaster Recovery, for full details.

IMPORTANT!  Store a set of your Replica Disaster Recovery disks
onsite and another offsite! There are many kinds of disasters.



If you prefer to work at the Host Replica Server’s NetWare console, you
can control the major Replica operations with console commands.

Replica Command Brief Description

REPLICA SECURITY [TO tape-label] Replicate server security

REPLICA SERVER [TO tape-label] Replicate all possible objects

REPLICA volume [TO tape-label] Replicate a single volume

REPLICA COPY [server\]volume1 TO volume2 Copy volume to another disk

REPLICA DISMOUNT ^volume Dismount a tape volume

REPLICA [HELP] Summary of commands

REPLICA IMPORT Import tape into database

REPLICA LIST TAPE List contents of current tape

REPLICA MONITOR Display device queue status

REPLICA MOUNT volume1 [USING volume2] Mount a tape for file access

REPLICA RECOVER DATABASES Recover Replica databases

REPLICA RECOVER SECURITY Recover server security

REPLICA RECOVER volume1 [TO volume2] Recover volume from tape

REPLICA SCAN FOR NEW DEVICES Scan SCSI bus for devices

REPLICA STOP ACTIVITY Stop current running job

REPLICA UTILITIES Label, eject, erase, unconditional
format, or retension tape
List tape labels or test tapes
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Loading Replica

If Replica startup commands are in AUTOEXEC.NCF, Replica loads
whenever you restart your server. If you have to load Replica separately,
use these commands:

Host Replica Server

REPLOAD

or

LOAD STACDAI

SCAN FOR NEW DEVICES

LOAD REPLICA

REPLICA.NLM has two load options you may wish to use in special
situations.

   -REMOVEQ Clears the device queues for all tape devices for the
server. You might use LOAD REPLICA -REMOVEQ if
your job queue is corrupted.

   -NOCLIENTS Locks out any client computers (workstations). Lets
you use console commands while locking out any
client access to the server. Makes the RECOVER
DATABASES console command available so you can
recover databases from any replicated tape. Replica
won’t see this server from an Administrative PC.

If you will use HP OpenView, use REP_SNMP instead at your Host
Replica Server or use these commands:

LOAD STACDAI

SCAN FOR NEW DEVICES

LOAD RE_AGENT

LOAD STACSDI -SNMP

LOAD REPLICA

To unload Replica, use REP_STOP.
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Copying from a Mounted Tape

You can always copy files normally at the Administrative PC from a
mounted Replica tape if you have access to it. However, Replica provides
an additional NLM that you can use at the server if you prefer.

REPCOPY.NLM lets you copy files quickly from a mounted Replica tape
to a location on the server’s hard disk. REPCOPY parses the tape to
locate the sectors that contain each file before copying the file.

Format:

LOAD REPCOPY source destination

Examples:

LOAD REPCOPY ^sys:data\bigfile.dbf  sys:temp
LOAD REPCOPY ^vol2:apps\*.dbf  sys:temp

Explanation:

source is the mounted tape. Specify ^volume:[path][\files]; may
include wildcards.

destination is a server disk. Specify volume:[path][\file]; the path
must exist.

Directory and file names must be specified in 8.3 (DOS) form. In most
cases, any long file names will be copied along with the short names and
the data, but the display shows only the 8.3 name. However, if you
specify a destination file name, REPCOPY will not copy a long file name
for the source file.

If source ends with a directory name, then all files in that directory are
copied. Source can include wildcards in specifying files. If it does, then
destination must end with a directory name.
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Compressed NetWare 4.x File Systems:
Set Convert Compressed to Uncompressed Option to 0 to keep files in a
compressed state.

NetWare 3.12 Servers:
REPCOPY uses the Direct File System from Novell. You will need to
update any NetWare 3.12 servers with the Novell patch NW3DFS.EXE
before loading Repcopy. You can get the file from Novell’s web site
(www.novell.com).

Recovering the SYS Volume

Because the SYS volume is in active use while a server is running, you
can’t recover it to the original location from the Administrative PC. You
can recover it at the NetWare console, however. In most cases, you’ll
want to make sure no clients try to access the server during the process.

To recover the SYS volume

1. Insert the tape containing the backed up SYS volume

into the tape drive.

2. At the console type these commands:

 UNLOAD REPLICA

 LOAD REPLICA -NOCLIENTS

 REP RECOVER SYS

3. Confirm the tape drive, job, and session if asked. Then

let it recover the SYS volume.

4. Restart the server.

The SYS volume is recovered and users can access it.

Selecting a Command

When you control Replica with NetWare console commands, messages
prompt you for the tape device if you have more than one. Replica uses
the tape currently loaded in that device rather than its tape databases
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when you control it from the NetWare console. However, Replica
updates the databases when you run a job, so they are up-to-date no
matter where you need them.

Note: Replica console commands let you replicate and recover data
for that Host Replica Server only.

The following tables help you decide what command to use. For the full
syntax and effects of Replica commands, see the Reference Section later
in this chapter. All commands begin with REPLICA, which you can
shorten to REP.

Replicate Operations

Replica uses the tape in the device to replicate the Host Replica Server
object immediately. If you don’t specify otherwise, data is appended to
the tape when you replicate data at the console. If you specify “TO tape-
label,” Replica labels the tape and overwrites any prior data.

To Replicate ... Use this command ...

All possible objects on the Host
Replica Server

REPLICA SERVER
[TO tape-label]

The security portion of the Host
Replica Server (NDS or Bindery)

REPLICA SECURITY
[TO tape-label]

Any single volume on the Host
Replica Server to tape

REPLICA volume
[TO tape-label]

IMPORTANT! Omit “TO tape-label” to append data to the tape.
Use “TO tape-label” to completely overwrite the tape. Replica asks
before relabeling the tape with the name you supply.

Recovery Operations

Replica uses the tape currently in the device to recover data to the Host
Replica Server. Before recovering data, it looks for the replicated volume
you requested. Replica skips other volumes on the tape. When Replica
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finds a volume of the type you specified, it asks if that is what you want.
When you respond with Yes, Replica begins to recover data.

To Recover ... Use this command ...

This Host Replica Server Restart with the Disaster Recovery
disks and follow the prompts

The security portion of the
current server (NDS or Bindery)

REP RECOVER SECURITY

Files by mounting a tape for
Direct Media Access

REP MOUNT volume1
[USING volume2]

(USING volume2 caches to
volume2 rather than SYS.)

An entire volume from tape REP RECOVER volume1
[TO volume2]

(Recovers to original volume
unless you use “TO volume2.”)

A volume from another volume
or server

REP COPY [server\]volume1
TO volume2

Utility and Status Operations

Replica uses the tape currently in the device. Before performing any
operation, it asks you if the next volume on the tape that matches what
you specified is what you want. When you respond with Yes, Replica
completes the requested operation.

To do this ... Use this command ...

Recover (replace) databases on
the Host Replica Server with those
on the current tape

REP RECOVER DATABASES
(Available only if you specified
the -NOCLIENTS option when
loading REPLICA.)

Import a tape into the Host
Replica Server database, adding to
the existing database

REP IMPORT
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To do this ... Use this command ...

Dismount a tape volume that was
used for recovering files

REP DISMOUNT ^volume
(volume names the tape
volume). It must start with ^.

Check for new tape devices REP SCAN FOR NEW DEVICES

Display information about objects
replicated on the current tape

REP LIST TAPE

Display the status of all device
queues

REP MONITOR

Erase, label, or retension a tape REP UTILITIES

Completely erase and reformat a
tape

REP UTILITIES
(Choose Unconditional Format)

List the label on the current tape REP UTILITIES
(Choose List Media)

Verify that a tape device is able to
replicate and recover data, while
completely overwriting a tape

REP UTILITIES
(Choose Test Tape)

Stop the currently running session REP STOP ACTIVITY

Reference Section
This section lists Replica console commands. It includes an explanation
of each command, an explicit statement of any assumptions, and how to
perform the equivalent operation using the Windows interface, if
possible. You can shorten REPLICA to REP if you prefer.

REPLICA SECURITY [TO tape-label]

Replicates the security components (NDS or Bindery) of the Host
Replica Server to the current tape in the current tape device. If you omit
“TO tape-label” Replica appends the data. Otherwise it labels the tape as
you request (after you confirm) and overwrites any prior data. If no tape
is available, Replica notifies you.
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Windows Equivalent   Use REPLICATE to specify NDS or Bindery as the
source, then choose a destination, schedule, and any options.

REPLICA SERVER [TO tape-label]

Replicates security and all possible volumes of the Host Replica Server to
the current tape. If you omit “TO tape-label” Replica appends the data.
Otherwise it labels the tape as you request (after you confirm) and
overwrites any prior data. If no tape is available, Replica notifies you.

By default, Replica allows full access with 7/24 Live Server Replication.

Windows Equivalent   Use REPLICATE to specify the server as the
source, then choose a destination, schedule, and any options.

REPLICA volume [TO tape-label]

Replicates the named volume (such as SYS) on the Host Replica Server
to the current tape. If you omit “TO tape-label” Replica appends the
data. Otherwise it labels the tape as you request (after you confirm) and
overwrites any prior data. If no tape is available, Replica notifies you.

By default, Replica allows full access with 7/24 Live Server Replication.

Windows Equivalent   Use REPLICATE to specify one volume as the
source, then choose a tape destination, schedule, and any options.

REPLICA COPY volume1 TO volume2

Replicates the entire volume1 to a disk volume or free space on the
Host Replica Server that you name as the destination. Include the server
name if volume1 resides on a remote server supported by a Replica
Server Agent, rather than on the Host Replica Server. You’ll have to log
into that server after entering the command.

If volume2 exists, Replica asks if it should overwrite the data, then
dismounts the disk if necessary. If volume2 doesn’t exist, Replica asks if
it should create a free space volume if enough free space is available.

Windows Equivalent   Use REPLICATE to specify a single volume as
the source, then choose a disk destination, schedule, and any options.
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REPLICA DISMOUNT ^volume

Dismounts the tape volume you name. You must include the ^ symbol,
because it is the first character of the mounted tape volume name. If the
volume is not mounted at the time, Replica ignores the command.

Windows Equivalent. Use STATUS, select the Mount Tape job, then
click Dismount.

REPLICA [HELP]

Displays a brief summary of the console commands.

No exact Windows Equivalent. Use HELP or the Help menu online.

REPLICA IMPORT

Imports database information from the current tape into the Replica
database. If no tape is available or the tape is already in the database,
Replica ignores the command.

Windows Equivalent   Use UTILITIES, Device tab, and the Import Tape
button.

REPLICA LIST TAPE

Displays a list of all the objects replicated to the current tape. Replica
can recover any of these objects.

Windows Equivalent   None. The objects listed at the console are
available when you try to recover any of them through Replica.

REPLICA MONITOR

Displays the status of each device queue (the tape device, as well as the
disk volumes and free space) on the Host Replica Server.

Windows Equivalent   Use STATUS, Device Status tab.
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REPLICA MOUNT volume1 [USING volume2]

Mounts the named volume (volume1) on the tape in the current tape
drive. You can accept or reject any volume of that name on the tape. The
mounted volume name begins with the ^ character. Once mounted, you
can map any drive letter to it from any workstation and use Direct Media
Access.

Replica creates a temporary cache on the SYS volume when it mounts a
tape for Direct Media Access. USING volume2 tells Replica to use the
volume2 for the cache instead. If you don’t have much free space on
your SYS volume, you may want to use this feature by specifying a
different volume as the cache location.

Windows Equivalent   Use MOUNT and provide a volume name. Click
the Mount Tape button.

REPLICA RECOVER DATABASES

(Available only if you specified the -NOCLIENTS option when loading
REPLICA.) Recovers the Replica databases with the databases stored on
the current tape. This completely replaces the previous Replica
databases on your server. Replica shows you the job name, date, and
time for each version of the databases on the tape. You’ll be able to
confirm from which job on the tape databases are recovered.

For detailed steps on preparing for and recovering databases, see
page 94 in Chapter 9, Troubleshooting.

After recovering the databases, be sure to unload Replica and load it
again without the -NOCLIENTS load option to allow workstation access.

Windows Equivalent   None.
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REPLICA RECOVER SECURITY

Recovers the NDS or Bindery information on the current tape (after you
confirm) to the Host Replica Server. If no tape device or tape is
available, Replica notifies you.

Windows Equivalent   Use RECOVER and choose NDS or Bindery as
the Source and Destination.

REPLICA RECOVER tape-volume [TO target-
volume]

Recovers the data in the named replicated volume on the current tape to
the volume of the same name or the named target volume on the Host
Replica Server. If you name an existing target-volume, Replica
dismounts it if necessary, recovers the data, then mounts it if it was
mounted originally. If you name a target-volume that doesn’t exist,
Replica creates a volume from free space if it can. If either volume is not
available, Replica notifies you. If you don’t specify a target-volume,
Replica recovers data to its original volume.

Windows Equivalent   Use RECOVER to specify the source and
destination.

REPLICA SCAN FOR NEW DEVICES

Scans the SCSI bus to locate any available tape devices and notifies
Replica that they exist. Normally, this occurs when you load Replica. You
can use it to update the Replica device list without restarting the server.

No Windows Equivalent.
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REPLICA STOP ACTIVITY

Immediately terminates the currently running session on the current
tape device. If no session is running on the current device, Replica
ignores the command. If you have multiple tape devices, you’ll see a list
from which to choose.

Windows Equivalent   Use STATUS, Device Status tab, select the
running job and click Abort.

REPLICA UTILITIES

Lets you manipulate, test, or identify the current tape. You can choose to
label, erase, retension, or unconditionally format the current tape.

Choose Test tape to verify that the drive and media can replicate and
recover data; Test tape destroys any existing data on the tape. Choose
List Media to display the label of the current tape or the labels of all
tapes loaded in an autoloader or other tape changer.

Windows Equivalent   To erase, label, or retension a tape, use
UTILITIES, Device tab. Unconditional format, Test tape, and List media
have no Windows equivalent.



Any complex software requires occasional troubleshooting. This chapter
can help you solve most problems that may arise while installing or
using Replica for HP SureStore Tape.

For help with ... See page ...
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Replica Memory Requirements

All NLMs require server memory. Replica requires a minimum of 4 MB
of additional memory to run on your system. If your system runs low on
server memory, you’ll see a NetWare message.

NetWare uses memory for each NLM that is running as well as each
volume that is mounted. A mounted tape volume for file recovery uses
the same amount of volume memory as mounting a NetWare disk
volume of the same size.

When Replica starts, it makes sure the server has sufficient memory to
replicate data. If there is not enough memory, a message lets you know
how much more you need to run REPLICA. You will need additional
memory if you mount volumes for recovering files and directories.

IMPORTANT! If your Host Replica Server is NetWare 4.11, make
sure that Replica jobs aren’t scheduled to run at the same time as
NetWare compression. Both use cache memory.

Installation Problems

This section tells you what to do if Setup is interrupted. The files Setup
places on the PC from which you install Replica and on the server being
protected are listed in the README.WRI file.

Setup Interruptions

If some interruption, such as a power outage, occurs before you finish
setting up Replica, you can easily recover. Remove any directories Setup
added to the server or the Administrative PC, then start Setup again.

On the Administrative PC

� Delete the Replica directory (C:\REPLICA) and any subdirectories.
You can ignore any files Setup placed in the Windows/System
directory.
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On the Server

� Delete the REPLICA directory in SYS:System. If Setup copied any
other files to SYS:System, just ignore them.

Replica Loading Problems

If AUTOEXEC.NCF contains the appropriate commands, Replica loads
whenever you restart your Host Replica Server. If you asked Setup not to
modify AUTOEXEC.NCF, you may have to load Replica separately at the
NetWare console. Use this command:

REPLOAD

The file REPLOAD.NCF includes these commands:

LOAD STACDAI

SCAN FOR NEW DEVICES

LOAD REPLICA

To unload Replica, use this command:

UNLOAD REPLICA

To unload all Replica components, use this command:

REP_STOP

If you want Replica to communicate with HP OpenView and you have
TapeAlert-supported hardware, use one of these instead:

REP_SNMP

The file REP_SNMP.NCF includes these commands:

LOAD STACDAI

SCAN FOR NEW DEVICES

LOAD RE_AGENT

LOAD STACSDI -SNMP

LOAD REPLICA
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To unload Replica when in this mode, use REP_STOP or use these
commands, in this order:

UNLOAD REPLICA

UNLOAD STACSDI

Loading Replica

If Replica or one of its components won’t load, these are the most
common causes:

No tape device present.

Make sure a tape device is installed and turned on at the Host
Replica Server. Replica uses the first tape drive it detects as the
default device. The ReadMe file contains a list of the supported
devices. Use LIST DEVICES at the console to see the currently
attached devices.

Valid ASPI SCSI driver not loaded.

Make sure you have a supported ASPI driver for the SCSI controller
being used. Make sure the SCSI chain is properly configured and
terminated.

Insufficient RAM in server.

Add RAM if necessary.

Outdated API Calls on NetWare 4.11

While NetWare loads STACOSM.DSK or RE_AGENT.NLM, you'll see a
message like this:

This module is using n outdated API calls.
You should upgrade to a later version.

You can safely ignore this message. It refers to APIs that Replica calls for
NetWare 3.12.
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Undefined Dynalink Error

If you see a message like this when Replica is loading, your system may
have a MPC250.DLL conflict. Many applications use MFC250.DLL, which
resides in the Windows\System directory. A few applications include
another copy of this DLL which resides in the application directory.

To solve the problem, remove MPC250.DLL from any application
directories. The application will use Windows\System\MPC250.DLL.

Problems Using Replica

On rare occasions, you may have difficulty using Replica. This section
includes solutions for problems you may encounter.

Server Login Errors (NetWare 4.11)

If you have Replica installed under NetWare 4.x, you may occasionally
encounter problems logging in to servers. If you get an “Invalid
Password” message, log in using the full context name, as in
CN=ADMIN.OU=OPERATIONS.O=STAC or ADMIN.OPERATIONS.STAC.

You can use Novell’s CX.EXE utility at the workstation to identify the
user’s context.

You may experience problems logging into a NetWare 4.11 Server that
does not have Bindery Emulation Mode enabled. Type the user’s full
context name to log in to the server.

Note: You need Bindery Emulation for the full benefits of Replica in
a network that depends on the bindery for communication. To make a
4.11 server appear in the Replica network list on this type of network,
set a bindery emulation context for the server. See your NetWare
documentation for details.
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Memory Errors during Replication
(NetWare 3.12)

If you see Memory Init errors on the NetWare 3.12 console while
replicating objects, you probably have very large hard disks and medium
to low memory. To use less memory, have Replica dismount volumes
rather than use Live Volume Replication.

To dismount volumes during replication:

1. Specify the source and destination as usual.

2. On the Options tab, check Dismount volume before

replicating.

3. Start or submit the job as usual.

Communications Problems

If your network has a mixture of 4.x and 3.12 servers, communications
problems between servers may cause Replica to behave erratically or to
abort when replicating or recovering data. You can solve the problem by
adjusting some SPX parameters on a 4.11 server.

Use SPXCONFG.NLM to change the parameters listed below on a 4.11
server. These settings will work fine with your other software as well.

Parameter Set to ...

SPX watchdog abort timeout 540

SPX watchdog verify timeout 110

SPX ack wait timeout 1500

SPX default retry count 50

Maximum concurrent SPX sessions 1000
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Replica at Administrative PC

Replica at the Administrative PC (client workstation) interacts with the
Replica software on the server, as well as with NetWare itself. This
section shows you how to locate servers, objects, or tapes that Replica
may not list.

Network list doesn’t show the server you
want, or server isn’t available for selection
� If the server isn’t listed, make sure that the server’s LAN driver is

loaded. Make sure any NetWare 4.11 servers use bindery emulation
mode.

� If you have the Replica Single Server for HP SureStore Tape
installed, you should see servers with this version as well as servers
with Replica Backup for HP SureStore Tape.

� If you can’t select the server, make sure the correct version of
Replica is loaded on that server.

If you can’t select the server in the Recover window, make sure it was
replicated. Only servers on which at least one object was replicated are
available for recover operations.

Recover Source tab doesn’t list all
replicated volumes

Any objects that you replicated to the current Host Replica Server are
available for selection on the Recover Source tab.

Here are two possible problems:

1. You haven’t selected the correct Host Replica Server. If necessary,
change to the appropriate one.

2. From within Windows, Replica uses its databases on the server to
identify which volumes have been replicated. If the databases are
corrupt or missing, Replica can’t locate the information. You can
recover the databases from the NetWare console.
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To recover Replica databases

1. Close Replica on the Administrative PC.

2. At the NetWare console, type UNLOAD REPLICA.

3. Type LOAD REPLICA -NOCLIENTS to load Replica and

prevent client use.

4. Insert a replication tape that was created when the

databases were available.

5. Type REPLICA RECOVER DATABASES and follow the

instructions on the screen to let Replica restore the

databases from the tape.

6. Unload Replica and load it normally with LOAD REPLICA.

At the Administrative PC, start Replica under Windows again. All
replicated volumes should be available on the Recover Source tab.

Recover Source tab doesn’t list all tapes
containing the selected object

When an object (either a server or a volume) is selected, Replica lists all
media on which it was replicated. Only media valid in the current tape
device are available for selection. If the tape was replicated on a different
Replica system, import the tape into the database.

Replica at the NetWare Console

You use Replica console commands (see Chapter 8) at the NetWare
console. Status and error messages are also displayed on the console.
See Console Error Messages on page 103 for help dealing with NetWare
error messages.
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Your monochrome monitor doesn’t display
Replica screens well

To force the NetWare console screens to display in monochrome, use
the -M option. You can change the LOAD REPLICA line in your
AUTOEXEC.NCF and REPLOAD.NCF files to read LOAD REPLICA -M.

Replica at the NetWare Console or PC

Replica may occasionally have problems that become apparent at either
the NetWare console or the Administrative PC. Here are some solutions.

Problem deleting a queued job

Normally, you can delete jobs in the queue that are waiting to run or on
hold. You can abort the job that is currently running, then delete it. In
rare cases, a job may not delete correctly from the queue. If this
situation occurs, try these steps, in order.

1. In the Status Window, Device Status tab, select the job, then click the
Delete or Abort button.

2. Close Replica on the Administrative PC, then unload Replica and
load it again at the console. Start Replica again at the Administrative
PC and try step 1 again.

3. As a last resort, you can use the -REMOVEQ load option to clear the
device queues for all devices for the server, including the tape
device and any disk volumes or free space. If you want to erase all
active, waiting, and holding jobs, use this option. You’ll have to
unload Replica first, then use LOAD REPLICA -REMOVEQ at the
console. After you are finished, unload Replica again and load it
normally.

 IMPORTANT! When you use -REMOVEQ, all your Replica
schedules are erased. You’ll have to schedule your server
replications again.
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Unable to access server resources during
replication

If you see this message while using Replica, the Administrative PC is not
able to communicate with the Host Replica Server. See the section
Communication Problems  on page 92.

Excluded deleted files

When you delete files from the server, your system records information
about those files in directories and in the FAT. Replica relies on the FAT
entries to decide what data to replicate. When you check Include
deleted files field while replicating data, you can salvage deleted files
after recovering the volumes.

When Replica does not include deleted files, FAT entries are cleared but
directory entries in the replicated volume may still point to previously
deleted files. These directory entries are no longer valid after you
recover a volume that didn’t have Include deleted files checked when
you replicated it.

If you expect to use SALVAGE or FILER in the future to recover files
deleted after recovery, you must purge the files as soon as the recovery
is complete to remove pointers to formerly deleted files that have not
been replicated.

1. At the Administrative PC, map a drive letter to the root

directory of the volume.

2. Change to the SYS:PUBLIC directory.

3. At a command line, type PURGE x:\  /A

 This command purges all traces of formerly deleted files

from the drive named as x:

Problem locating tape devices

Replica is a NetWare loadable module; it depends on NetWare to work
correctly. If NetWare can’t identify a disk volume or tape device, neither
will Replica.
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The ReadMe file contains a list of tape devices that Replica supports.

Suppose Replica doesn’t find a supported tape device that you know
exists. Here’s what to do:

1. At the tape server console, type REP SCAN FOR NEW

DEVICES, then type LIST DEVICES.

 If the tape device is listed, start Replica from Windows

again and you will find the device in the dropdown list.

2. If Replica still cannot locate the device, you may have a

hardware problem.

Tape media problems

If you have problems with a tape, the problem is probably with the tape
itself. Use standard techniques to verify that the tape is valid.

� Make sure the tape is good. An old tape used extensively in any tape
drive may be worn out or unusable.

� Use Utilities to retension the cartridge spool.

� Check the write-protect switch on the tape cartridge.

� Use a tape-cleaning cartridge to clean the heads.

Tape won’t eject

Most QIC tape devices don’t respond to software ejection. Manually
remove the tape.

Disaster Recovery Problems

For standard Disaster Recovery with Disaster
Recovery disks only.

Your Disaster Recovery disks get your server up and running so that
Replica can communicate with it. By themselves, they don’t recover
anything to the server.

You hope never to need the Replica disaster recovery feature. But if you
do, you want it to work. This section shows how you can make
absolutely certain your Disaster Recovery disks contain all the files
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needed to restart your NetWare server. It also shows how you can
manage if your Disaster Recovery disks are damaged or missing.

Creating your Disaster Recovery Disks

When creating Disaster Recovery disks, Replica formats disks that aren’t
yet formatted. Replica deletes files on used disks and verifies the format.

If the Create Disks process fails during the formatting, you may have a
bad disk or its formatting may be a bit off. Try a new disk or try this:

1. Format the disk under Windows or using the DOS

FORMAT command.

2. Click Create Disks in the Replica Disaster Recovery utility.

Verifying Disaster Recovery Disks

On some occasions, Disaster Recovery disks need information that
Replica doesn’t recognize when it creates the disks. For example, if your
LAN drivers are loaded through SNMP CFG files, you'll have to add the
LOAD and BIND commands and the drivers to Disk 2 of your Disaster
Recovery disks after Replica creates them.

It’s a good idea to occasionally verify that your disks contain the correct
information. You can also modify a set of disks to recover a server with a
different configuration.

Most servers require two disks. The first contains the files needed to
bring up DOS and get the process started. Later disks load NetWare
modules. The last disk loads the rest of the NetWare modules and starts
recovering data from the current tape.

You can check one file on each disk that follows the first to make sure
your Disaster Recovery disks contain the needed files. The AUTOEXEC.2
and later files load the drivers that start up NetWare on your server. You
can see what drivers are loaded and which options are specified. These
are text files, so you can modify or add lines as needed. AUTOEXEC.2
loads drivers included on disk 2. If your server requires a third disk,
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AUTOEXEC.3 loads drivers included on that disk. If you add a LOAD
command, be sure to add the driver to the same disk.

Note:  If you want to use your Disaster Recovery disks to start
recovery of a server with a different configuration, you can modify the
AUTOEXEC.n file on each disk after the first. Make sure that all disk,
LAN, and SCSI drivers are loaded for the server you wish to recover.

Example for Host Replica Servers

Here’s a sample AUTOEXEC.2 file for a set of Disaster Recovery disks:

LOAD CLIB.NLM
LOAD NWPA.NLM
LOAD NWPALOAD.NLM
LOAD ASPITRAN.DSK
LOAD AHA1540.DSK port=330 int=B dma=5
LOAD STACDAI.DSK
LOAD CSLSTUB.NLM
LOAD IPXR
LOAD MSM.NLM
LOAD ETHERTSM.NLM
LOAD TOKENTSM.NLM
LOAD EXP16.LAN port=300 frame=ethernet_802.3 name=exp_1
BIND ipx to exp_1 net=f000
LOAD TLI.NLM
LOAD SPXS.NLM
LOAD SMDR.NLM
LOAD RE_AGENT.NLM -DR
SCAN FOR NEW DEVICES
LOAD STACSDI.NLM
LOAD MATHLIB.NLM
LOAD REPLICA.NLM -RECOVER
REM STOP

Note: The -RECOVER load option appears on the last Disaster
Recovery disk; it  tells Replica to immediately recover the full server
using the currently loaded full server replication tape.
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Recovering from Disasters

ESSENTIAL: If you don’t have a set of Disaster Recovery disks, you
won’t be able to recover the server automatically. You can still recover
the data after reinstalling DOS, NetWare, and Replica.

This section describes what to do if:

� You have a server replication tape but no Disaster Recovery disks.

� You have Disaster Recovery disks but they are out of date or don’t
match the new hardware or configuration of the target server. (You
didn’t make new Disaster Recovery disks since you upgraded your
server or changed your configuration.)

To recover a Host Replica Server with no Disaster
Recovery disks, but a full server replication tape

 The first four steps bring up the server and Replica.

1. Reformat and repartition the hard disk if necessary.

2. Reinstall the operating system (DOS).

3. Reinstall NetWare and any upgrades.

4. Reinstall Replica from the Administrative PC.

5. Update the STARTUP.NCF file as specified in Setup and

then restart the server.

IMPORTANT! If you want the complete server to be exactly as it
was at the time of the last full server replication, do steps 5, 6, and 7.
To leave the results of steps 2 through 4 intact and recover only
NetWare volumes, ignore steps 5, 6, and 7, and then continue with step
8.

5. At the NetWare console, load Replica with REPLOAD.

6. At the Administrative PC, start Replica and create new

Disaster Recovery disks.

7. Close Replica, return to the NetWare console, and do a

full Disaster Recovery, starting with your disks.
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IMPORTANT! To recover NetWare volumes if you didn’t use
step 5, continue with step 8. You won’t be able to recover data in the
non-NetWare partition.

8. At the tape server console, type UNLOAD REPLICA if it is

loaded, then reload it with LOAD REPLICA -NOCLIENTS

9. Insert the tape that contains the full server replication

and type REP RECOVER SYS to recover the SYS volume

from the tape.

10. Type REP RECOVER DATABASES so Replica will know

what was previously replicated.

11. Unload Replica completely by typing REP_STOP at the

NetWare console, then restart it with REPLOAD.

12. At the workstation, use Replica to recover any remaining

individual volumes.

 Note: If you prefer, you can recover the NetWare volumes on
your Host Replica Server with console commands.

If your Disaster Recovery disks are out of date

 It is possible that the changes you made to your system

will not affect the disaster recovery process.

1. Try to recover your server using the disks you have and

your latest full server replication tapes.

2. If any changes to your system are not included in the

recovered server, make any upgrades again.

3. Once the server is recovered or rebuilt, create a new set

of Disaster Recovery disks.

If the procedure above does not recover your server, manually modify
or update your disks as described earlier in this section.

Disaster Recovery of Server with
Corrupted Partition Table

If your server's disk has a corrupted partition table, you won't know it
until the disaster recovery process is well underway. The Disaster
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Recovery disks start up the server and Replica starts the recovery from
the tape. However, Replica won't be able to create the non-NetWare
partition. You can clear up the problem, then run the Disaster Recovery
procedure again, successfully.

Disk Type How to fix

SCSI • Run a low-level format on the hard disk before
restarting with the Disaster Recovery disks.

IDE • Run FDISK to delete all partitions.

• Use FDISK to create a small DOS primary
partition.

• Format the DOS partition and make it bootable.

• Confirm that you can boot the system into DOS.

Finally, start the disaster recovery process again with the first Disaster
Recovery disk. This time, the process will work.

Uninstalling Replica

Occasionally, you may want to uninstall Replica, then install it again in a
different location or with different options. Replica includes an uninstall
utility to help.

To remove Replica from your system
1. At the Administrative PC, click REPLICA Uninstall in the

Windows Start menu.

2. Follow the directions on the screen.

Uninstall removes files it placed on the Administrative PC during Setup. If
you added any files while using Replica, Uninstall won’t remove them. If
the Replica directory remains on your PC, delete it and all of its
subdirectories.
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Uninstall also removes files it placed on the server. If the
SYS:System\Replica directory remains, delete it and all of its
subdirectories.

If any of these files remain in the SYS:System directory, delete them:
DBE.NLM
RE_AGENT.NLM
REP_STOP.NCF
REPCHECK.NLM
REPCOPY.NLM
REPLICA.MSG
REPLICA.NLM
REPLOAD.NCF
STACDAI.DSK
STACOSM.DSK
STACSDI.NLM

Console Error Messages

While loading or using Replica, you’ll see messages from NetWare as
well as from Replica modules. Many of these messages are self
explanatory. If something is missing, for example, make sure it exists
before trying again.

This section lists messages that may occur and provides suggested
solutions to each problem.

MESSAGE

Loader cannot find public symbol: AspiEntry

Possible Cause

� No ASPI-compliant SCSI tape driver is loaded.

Suggested Solution

� Run MODULES at the server console to see if the required modules
are loaded.
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� Check with your SCSI controller manufacturer to make sure you
have the latest drivers for the version of NetWare you are using.

MESSAGE

Loader cannot find public symbol: ASPI_Entry
Loader cannot find public symbol: DAI_DeviceSupportsTapeAlert
Loader cannot find public symbol: DAI_ReturnChangersInfo
Loader cannot find public symbol: DAI_DeviceHadErrors

Possible Cause

� STACDAI NetWare driver is not loaded.

� No SCSI tape device is found.

Suggested Solution

� Make sure STACDAI is loaded. Run REPLOAD again to make sure.

� Check to see if the tape device you are using is supported by
Replica, properly connected, and powered up.

� Check for unique SCSI ID settings and proper SCSI termination.

MESSAGE

volume server_name/SYS almost out of disk space (while
mounting a replicated tape volume)

Possible Cause

� Replica writes a cache file to disk while mounting a tape volume.
The SYS volume on your server does not have enough space
available to create the cache file.

Suggested Solution

� Remount the tape so it will write the cache to a different volume.
Use the following command at the NetWare console:

REPLICA MOUNT tape-volume-name USING cache-volume-name
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MESSAGE

Short term memory allocator is out of memory. # attempts to
get more memory failed. Error initializing memory.

Cause

� Your server does not have enough free memory to complete the
current Replica operation.

Solution

� Replica requires 4 MB of available RAM to load and function
properly. You may be able to unload unnecessary NLMs or
dismount unneeded volumes.

� Restart the server (power-down, then back up) to free resources,
then try again.

� If you can’t free up enough memory, you’ll have to add more
memory to your system.

MESSAGE

Device xxxxx deactivated due to device failure

Possible Cause

� Defective tape device

� Defective tape media

Suggested Solution

� Try using a new or different tape.

� If that does not solve the problem, use a cleaning cartridge in your
tape drive.

� If cleaning does not solve the problem, your tape drive may need
servicing.

MESSAGE

Error recovering object nnnnn (during recovery of NetWare
Directory Services NDS)
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Possible Cause

� Replica is trying to recover objects to NDS that no longer exist.

� NDS is corrupted.

Suggested Solution

� If the object in question no longer exists, disregard the error
message.

� Otherwise, run NetWare’s DSREPAIR.NLM utility before replicating
to fix any possible problems with NDS before replicating the object.

MESSAGE

Mirrored copies of the FAT don’t match. Volume xxxxx not
mounted (after replication to disk or recovery)

Possible Cause

� The volume may be corrupt.

Suggested Solution

Run the NetWare utility VREPAIR.NLM on the volume. If this does not
resolve the problem, repeat the replication or recovery operation.
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